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Notice to User: 

This End User License Agreement ("Software License Agreement") is a legal document between you and PCSYS A/S
("PCSYS"). It is important that you (“Customer”) read this document before using the PCSYS-provided software. 

Grant of License
PCSYS grants Customer a non–transferable, non–exclusive, limited license to install and use a copy of the PM5
software on your compatible computer, up to the Permitted Number of computers, subject to the terms and conditions
of this agreement. Legal title to the Software and Software documentation provided under this agreement shall remain
in PCSYS as its sole property, subject to Customer’s rights as specified in this agreement.

Use of Software
PCSYS represents that it is the owner of the Software and has the right to grant the License. The parties agree that the
Software is the sole and exclusive property of PCSYS, including all applicable rights to patents, copyrights, trademarks
and trade secrets and is provided for Customer’s exclusive use for the purposes of this agreement.
The PM5 database is for each license granted to you, limited to be installed on one pc or server. The database may be
used for one or multiple physical sites or locations within the same company with the same CVR/VAT number. Other
sites or locations with different CVR/VAT numbers may not use the same system, unless purchase of the multiple site
option(s). You may make a backup and archival copy of the PM5 database, provided your backup and archival copies
are not installed or used on any computer. 
The Client side of the software may be installed on an unlimited numbers of computers. The number of concurrent
users is limited by the license you have purchased.

License Codes 
For each license granted to you under this Agreement, other than evaluation licenses, PCSYS or its Authorized
Reseller will provide you with a unique license code for use by you (“Customer”). The license code is your
proof-of-license. Retain a copy for your records. You may move Software from one pc or server to another, as a
replacement. 

Warranty 
Except as expressly set forth herein, PCSYS makes no warranties, expressed or implied, including, but not limited to,
implied warranties of merchantability and fitness for a particular purpose. In the event PCSYS fails to remedy material
defects in the Software, Customer's sole remedy shall be to receive a refund of any license fees paid hereunder for
the current term of this License.
PCSYS shall have no liability with respect to its obligations under this agreement or otherwise to licensee or any
sub-licensees for special, incidental, consequential, punitive or exemplary damages even if PCSYS has been advised
of the possibility of such damages. In no event shall PCSYS 'S liability for any reason and upon any cause of action
whatsoever exceed the payment made by customer to PCSYS under this agreement.
PCSYS shall be relieved of any and all obligations with respect to this section for any portions of the Software that are
revised, changed, modified, or maintained by anyone other than PCSYS.
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Termination 
If a particular license granted to you is for a limited term (as indicated on the packaging that accompanies the
Software or on the applicable invoice, license certificate or other product documentation provided to you by PCSYS or
its Authorized Reseller in connection with the Software, or on the screens displayed by the Software when it is initially
installed), then that license terminates – and the Software will no longer continue to operate -- upon expiration of that
term. To continue using the Software after such expiration, you will need to purchase a new license from PCSYS, if
available, at current prices and terms. 
PCSYS may terminate this Agreement, effective immediately upon written notice to you if you (a) fail to pay any portion
of the license fees when due and fail to cure such non-payment within thirty (30) days after receipt of notice of same, or
(b) if you otherwise breach any provision of this Agreement. 
Upon expiration or termination of this Agreement, you must erase or otherwise destroy all copies of the Software and
your rights hereunder will immediately end. 

Governing Law
This agreement shall be construed and the legal relation between the parties determined in accordance with laws of
the state of Denmark.
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1 Quick guide for PM5
Here is a quick guide to get you started using PM5. There are certain things that has to be done in
the right order to get the best out of the system from the beginning.

The sections in this quick guide are not described in detail. If you need further explanation you can
read more in the full section of the manual.

Good luck with the program.

1.1 System Requirements
Client installation Database requirements 

Processor 1-gigahertz  (GHz)  or  faster  processor
recommended 

1-gigahertz  (GHz)  or  faster
processor recommended 

Operating System Windows  XP  with  SP  2  or  later;
Windows Server 2003 with SP 1 or later 

Windows  XP  with  SP  2  or  later;
Windows  Server  2003  with  SP  1  or
later 

.NET Framework .NET Framework 2.0 SP 1 or later .NET Framework 2.0 SP 1 or later 
IIS Internet Information Services (IIS) version

5.00 or later* 
Internet  Information  Services  (IIS)
version 5.00 or later 

Free Disk Space 500 MB of Free Hard Disk Space Plus 1 GB of Free Hard Disk Space
for  database  and  SQL  Server
Express 

RAM 512 megabytes (MB) of RAM or more; 1
gigabyte (GB) or more recommended 

1  gigabyte  (GB)  or  more
recommended 

Drive CD-ROM or DVD-ROM drive CD-ROM or DVD-ROM drive 
Video  Graphics
Adapter and Monitor
 

Super  VGA  (1,024x768)  or  higher-
resolution video adapter and monitor 

Super  VGA  (1,024x768)  or  higher-
resolution video adapter and monitor 

Network LAN Connection to Database Server LAN Connection 
Database Server SQL  Server  2005  Express  Edition  or

higher** 
SQL Server 2005 Express Edition or
higher 

*IIS is required only if you are installing the PM5 Web Service. 

**Starting with v5.05, SQL Server 2005 Express Edition has been bundled with the PM5 installer.
So, you can install it if you do not have it. 

1.2 Installation of empty database
When you install PM5 you will choose between a demo, empty or existing database.

Choosing demo database gives you an example of the structure of the program and the many
relations there is. You can also put in a couple of your own data as test. But before you start the
use of the program in production you should start with an empty database.

If you are going to use the system where you installed the demo as your production server you have
to clean up data related to the demo installation first. To install the empty database you have to
uninstall the program, delete the database in SQL Management Studio and then install the program
again.
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1.3 Decisions before you start
Before you start entering machines, spare parts and tasks in PM5 there are some decisions to
make regarding naming and numbering your machines and spare parts. It's also a good idea to
visualize the structure of your locations.

The more decisions you have made from the beginning the easier it will be entering data. And it's
less likely that you have to make changes and reenter information.

We are happy to give input to this process and here is some advice to get you started:

1. Use naming for machines and spare parts as the ones you are using already.
2. Use a logic that makes it easy for new employees to learn the names.
3. Searches are done in intervals so to make it easy to find all trucks naming could be: "Truck, 3

Montini" and "Truck, 4 Nissan".
4. Picture an overview of your factory so you easily can see how many levels your locations

hierarchy should have, which machines that are placed where and which employees should have
access to these machines.

1.3.1 Move ahead at pace - take one section at a time

To get the most out of PM5 you should consider which data you want to include in the program.
Where is it important to start (registering faults, managing spare part stock, management of
obligatory maintenance etc.). And where is your detail limit (screws / bolts, all spare parts / only the
most common, etc.)?

There is a lot of information to be entered in PM5 but choose which you want to use from the
beginning and which you will be postponing for a later time. 

1.4 Start in the administration module
Before you start entering data in the client module you have to enter data, based on your decisions
earlier, into the administration module.

We will now go through the sections that are most relevant.

1. Launch PM5.
2. Log in with user "PM5" and password "pm5".
3. Open the administration module (Ctrl. A).
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1.4.1 System tools

Links:

Locations
User Groups
Users
Custom Field Groups

1.4.1.1 Locations

Create at least one location or machine group where you can attach your first machines. Right click
with the mouse and choose from the menu.

1.4.1.2 User Groups

Decide which persons should have administrator rights.
Create at least one more group - More if you already know what groups you will be needing.
Assign rights to every group for actions, locations and tabs.
Note that a user can be a member of multiple user group and thereby the user can have different
access levels to different locations.

For the tab "locations" there is some special rules. To avoid accidentally removing all locations from
a group you have to mark first the location and then click the checkbox next to it.

Blank = No rights
Checked = All rights
Checked Gray or Boxed = Rights to the location and the machines selected and machines that you
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create.
Name in Italic = No rights to the location but there is some rights further down the tree for other sub-
locations.

If you have many locations and want to check them all you can right click and choose "Check all" or
"Uncheck all" and everything below that location will be checked.
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1.4.1.3 Users

When the user groups have been created you can create the users and attach them to the created
user groups.

1.4.1.4 Custom Field Groups

Custom Field Groups enables you to add your own fields to each tab. Maybe you would like to have
data about which fuse box is attached to a machine, Primary responsible, security measures and so
on noted on each machine. Data that you normally store on papers in the archive but actually could
be useful to have at hand when working in PM5.

Custom Field Groups are created to for example all pumps have the same information available.

This area is not necessary to define before you start but if you have the information that you wish to
enter already it will be easier to do this already at this point.

1.4.2 System Variables

Configuration of default values in PM5 is done in this section.
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1.4.2.1 Client

Links:

Machines
Faults
Tasks
Spare Parts
Supplier

1.4.2.1.1  Machines

Create at least 1 Machine Type.

1.4.2.1.2  Faults

To be able to register a fault you have to create the categories below:

Types - This is the definitions a user should be able to choose between when a fault is registered.
The alarm set is being used if you want to get informed when a fault occurs too often. Choose
properties and enter how many days you will allow between faults of this type.

Cause Types - This is the definitions to choose from after correcting a fault and you have found the
cause of the fault.

Stop Groups - This is for grouping machines where a stop on one machine influences other
machines in the group. Typically in connection to a line assembly. Create describing group names
and then put in the machines in the respective groups.



17Quick guide for PM5

© 2010 PCSYS A/S

1.4.2.1.3  Tasks

Create at least one Task Type - more if you already know what types you are going to need.
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1.4.2.1.4  Spare Parts

Create at least one Spare Part Group if you want to manage spare parts in PM5.

Create at least one Manufacturer of spare parts. In some cases manufacturer and supplier will be the
same.

Create at least one Store if you want to manage inventory of spare parts in PM5.

Create at least one Consumption Type if you want to attach a spare part to a task in PM5. This
could be maintenance, lubrication etc.
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1.4.2.1.5  Supplier

Create Phone Types if you want mobile or direct phone number directly on the supplier form.

1.5 Continue in the Client Module
You can now close the Admin module.

Right Click with the mouse in the left and choose refresh and the the changes you have just done
will be available in the client.
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1.5.1 Create a supplier

Start by creating a Supplier.
All machines and spare parts has supplier as a mandatory value.

You can now create your machines, tasks, spare parts and the remaining suppliers.



21Quick guide for PM5

© 2010 PCSYS A/S

1.5.2 Enter more data

You can choose what data you want to input in the beginning. A spare part can be attached to a
machine but in which order you create machines and spare parts is up to you.

1.5.3 Copy machine data

If you have several machines of the same kind which has the same types and tasks then you can
copy date from one to the other. Start by creating one machine and enter all the data for that one.

Mark the record and chose file->copy. Give the machine a unique number and choose the location
for the machine.

When you push save you now get the option to transfer tasks and spare parts from the original to
the copy.
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1.5.4 Keyboard short cuts

PM5 contains some useful keyboard short cuts.

Push "Alt" and then choose the number or letter you wish.

And then choose the letter at the next level

You will quickly learn the shortcuts you use the most.
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2 Client Application
After logging in to PM5, the application will display the client module. This is where you will work
mostly on PM5.

The Client module holds the basic feature of PM5. In here you will see the five main tabs –
Machines, Tasks, Spare Parts, Suppliers and Activities/Faults. You can learn more about them by
reading their corresponding sections.

The Client module also provides you tools to help increase your productivity: Location, Filter,
Purchasing, Consumption and Reports tools.

“Location” permits you to group together Machines, Tasks, and Activities and Faults that share
common characteristics. A Location can be a large geographical area such as Copenhagen or it can
be as small as a cabinet in the storage room. You can learn more about this tool here.

The “Filter” allows you to restrict data shown in the five main tabs to the criteria you specify. This
means you can use the Filter to restrict the Machines shown to only the Machines you bought last
month, last year or in between a certain period of time. You can also specify advanced criteria in the
Filter, such as restricting the Machines shown to only those bought at a certain date and only those
bought from a certain supplier. The Filter is a very powerful tool and is discussed in greater detail in 
Filter.

In “Purchasing,” you can create purchase orders to Suppliers. Purchasing also helps you keep track
of the Spare Parts ordered. You can learn more about this tool here.

“Consumption” allows you to keep track of Spare Part consumption. Spare Parts can be associated
with Tasks to keep track of their consumption.

The “Reports” tool allows you to generate printable reports on Machines, Tasks, Spare Parts,
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Consumptions, Suppliers, Activities, Faults, Persons, Groups, Stops, Use of Manpower and
Reorders. With reports, you can get a print out of all the Machines you have and their associated
Spare Parts, a print out of all the Tasks performed on a specific Machine and a lot of other
combinations. Aside from giving you a copy of your inventory, Reports allow you to see the efficiency
of your business. By reading a report on Use of Manpower, you will be able to see who among your
employees are able to make good estimates and who are able to finish their jobs within the specified
time limits. 

To give you even better control over PM5, it provides you with a tool called “Administration” With the
Administration Tool, you can specify who is allowed to use PM5, what they are allowed to do and
what they are not allowed to do. To learn more about Administration, click here.

2.1 Location
The Location Pane is found in the left hand side of PM5. It displays Locations and Machine Groups.

You can click View > Location to make it display.

It helps you organize your Machines by allowing you to group them by Location or Machine Group. 

This is similar to the concept of Files and Folders in Windows. In Windows, you can organize your
Files by grouping them in Folders. In PM5 you can organize your Machines by grouping them in
Locations and Machine Groups.

You can learn how to create a Location or Machine Group by reading Locations and Machine
Groups here.
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2.2 Filter
The Filter Pane is found in the bottom of PM5. It displays criteria that you have specified.

You can click View > Filter to make it display.

It helps you find what you are looking for faster by allowing you to specify criteria that will determine
which Machines, Tasks, Spare Parts, Suppliers and Activities / Faults will be displayed. A filter can
either be a System or Personal filter. A filter that is saved as a System filter will be available to all
users of PM5 while on the other hand, a Personal filter as the name implies means that the filter will
only be available to the user who created it. 

Note: Starting v5.06, the 'Apply' button is removed. To apply changes in your current filter without
deactivating it, simply put the cursor focus on the Values field and press the [Enter] button on your
keyboard.

The Filter tab - Showing how to apply modified filter without deactivating it

2.2.1 Filter Fields

Fields - correspond to the columns found in each Main Tab of PM5. For example, The Field
“Machine No” in Machines corresponds to the “Machine Number” column in Machine.
Here is a summary of the Fields supported by the Filter:
Tab Name Supported Fields
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Machines Machine No, Machine Name, Machine Type,
Machine Date, Measured Parameter, ID Code,
Active Machine, Stop Group, Machine Note,
Manufacturer Name, Price, Account Number,
Capacity, Power, and Measured Value

Tasks Task Name, Type of Task, To be Signed By,
Active Task, Technical Group, Priority, Estimated
Manhours, Locked, Interval (Days), Measured
Unit, and Task Note

Spare Parts Spare Part No, Spare Part Name, Group of Spare
Part, Type No, Dimension, Spare Part Note,
Manufacturer Name, Barcode, Unit and Cost Price

Suppliers Supplier No, Name of Supplier, Telephone
Number, Country, Address, Zip Code, City, Fax,
E-mail and Supplier Note

Activities / Faults Status, Type, Person, Date, Done Date, Priority,
Fault Type, Discovered By, Approved By, Cause
Type, Started, Carry Out, Man Hours, Fixed Date,
Expected End Date, Activity Note, Alarm Code,
Fault Priority, Technical Group, Fault Description,
Fault Estimated Man Hours, Expected End Date,
Approval Required, Approved, and Solution 

Criteria - the purpose of Criteria is to specify how you want Value to be treated. Each symbol in
Criteria has a unique way of handling Value.
Here is a summary of the name and purpose of each symbol in Criteria:

Symbol Name Purpose
* Asterisk or Wildcard To show all fields that contain

part of or the entire value
specified

= Equals To show all fields that contain
exactly the value specified

> Greater than To show all fields that contain a
value that is greater than the
value specified

< Less than To show all fields that contain a
value that is less than the value
specified

<> Not equal to To show all fields that are not
equal to the value specified

[..] Between To show all fields whose values
are in between the values
specified. There is a special
requirement for the “[..]” or
Between symbol. You will need
to enter two values separated by
a semicolon “;” for it to work
properly. 

Value - contains the characters that you want the Criteria to be applied to. These characters may
be numbers, letters or a combination of both.

Location Check boxes (LCB) - seen on top of the filter. It control the filtering of the main tabs by



27Client Application

© 2010 PCSYS A/S

location.You will see that the Machines LCB is permanently checked. This is because Machines are
always filtered by location. If you change locations in the Location Pane, only the Machines that are
in the selected location will appear in the Machines Tab. The other LCBs control whether the Tasks,
Spare Parts, Suppliers and Activities / Faults Tabs are filtered by Location.

Location Check Boxes

Filter Row Check boxes (FRCB) - appears on every filter row. The FRCBs control which tabs will
be filtered by the Field, Criteria and Value on the filter row. By default, all FRCBs are checked. To
limit which tabs the filter will be applied to, check only the FRCBs of the tabs you want to be filtered.
For example, if you want only the Machines Tab to be filtered by the specified Field, Criteria and
Value, check only the Machines FRCB.

Filter Row Check Boxes

Operators - link filter rows together. Depending on the operator selected, the criteria in one row or in
all rows may be applied. There are two operators found at the end of each row – the AND operator
and the OR operator. The AND operator requires the criteria of the all the filter rows it links to be
met. The OR operator requires the criteria of only one of the filter rows it links to be met.

2.3 Main Grids
When you mark a record in the top grid the information in the sub-grid will update to display data
related to the chosen record.
If you right click the column header you can choose which columns to show in your grids.
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2.3.1 Machines

The machines pane gives you an overview of all your machines. The list is per default limited to the
machines located in the location you have chosen in the location tree.

In  PM5,  a  machine  is  anything  that  has  properties  and  needs  maintenance.  It  can  be  a  car,
refrigerator, an MP3 player or even a garage (because rooms still need maintenance, i.e. cleaning).
Creating  a  machine  allows  you  to  gauge  its  performance  and  schedule  preventive  maintenance
tasks. This way, you get to see if a machine  is  doing  its  job  efficiently  and  when  maintenance  is
due.
The  machines  tab  has  seven  sub  tabs:  details,  tasks,  activities,  spare  parts,  faults,  stop  and
attachments. You can find more information about each sub tab by reading the Machines Sub Tabs
section.
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2.3.1.1 Machine Fields

When you create a spare part, you will be shown a set of fields. Each field is explained below.

Note: You can only select values in the Location, Type, Supplier, Manufacturer, Account Number,
Stop Group and Measured Parameter fields. If you want to add, edit or delete values in Location,
Type, Supplier, Manufacturer, Account Number, Stop Group and Measured Parameter, please click
on their underlined names in the image.

Machine Number - the unique identifier for a machine, hence one of the required fields to fill out to
be able to save a machine.
Active Checkbox - in this check box, you define the machine as active. This means that the
maintenance program is activated and new tasks will be scheduled for the machine. Machines not in
use, should be checked as not active.
ID Code - this field is only optional. This is an alternative way to identify your machine.
Machine Name - the name of the machine. 
Location - the place where the machine is located.
Date - refers to the date when the machine was started to use. Often it is the date when the
machine was installed or bought.
Type - the type of the machine.
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Machine Note - in this field you can note down other information regarding the machine. 
Supplier - the dealer of the machine.
Manufacturer - the producer or maker of the machine. As you explore PM5, you will notice that
manufacturer's list is defined only in the spare part's node of the administration module. This is
because the creator of the machine can also be the creator of the spare part of that machine.
Account Number - the account number where the machine belongs to.
Price - the cost of the machine.
Capacity - the maximum amount of the machine.
Power - the power or strength of the machine.
Stop Group - the Stop group where the machine belongs to.
Measured Value - in this checkbox, you allow the machine to use a measured parameter to predict
its next activity date.

2.3.1.2 Create Machine

To create a machine you can do one of three things:

1) File -> New...
2) CTRL + N
3) Right click the grid and select "New..."

This will get you this form.
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Notice that "Location" already has location 01 entered in this view. This is because location 01 has
been chosen in the location selector. If focus had been on the root (PM5) then you would have to
choose a location on the form.

1) Provide the machine number.
2) Determine if the machine is Active or not. By default, a machine is always Active.
3) Put the ID Code of the machine.
4) Give the machine a name.
5) Select where the machine is located.
6) Select the date when the machine was bought or installed.
7) Select the type of machine. (see how to define types here)
8) Enter a describing text for the machine.
9) Select the Supplier of the machine.
10) Select the Manufacturer and the Account Number of the machine. (see how to define the list 

here)
11)  Provide information for the Price, Capacity, and Power fields of the machine.
12)  Select the Stop group of the machine.
13)  Decide whether to use Measured Value for the machine or not.
14)  Click on the Save button.

Note: Machine Number, Machine Name, Location, Type and Supplier are required fields. You cannot
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save a machine if the required fields are empty. All other fields are optional.

2.3.1.3 Edit Machine

To edit a machine, select the machine you want to edit and do one of the following:

1) Push "Enter"
2) CTRL + E
3) Right click and click "Edit..."
4) File -> Edit

Then you will get this form.

Change the details of the machine that you want to change and click Save. 

2.3.1.4 Copy Machine

To make it easier for you to create several machines of the same type, with the same tasks, the
same spare-parts etc. PM5 can copy an existing machine. To do this do one of the following:

1) File -> Create copy...
2) Right click and choose "Create copy..."
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3) ALT+F, C

After you have made the modifications to the machine info and click save, if the machine has
existing spare part associations, you will be asked if you want to copy the association of spare parts
from the original machine.

After replying to this question, if the original machine has existing task association, you will be
asked if you want to copy the tasks for this machine
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And if you reply yes to this question you will be asked to choose a date for the activities. The date
you choose will be used for all tasks first occurrence.
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After choosing the first activity date of the machine, if the original machine has existing
attachments, you will be asked if you want to copy also the attachments for this machine



36 PCSYS Maintenance 5

© 2010 PCSYS A/S

Note: You are required to change the Machine Number and select the Location of the machine when
making a copy of a machine.

2.3.1.5 Delete Machine

To delete a machine, select the machine and do one of the following

1) CTRL + D
2) Right click and click "Delete"
3) File -> Delete

You will be asked if you want to continue this operation. Mark the check box and click Yes.



37Client Application

© 2010 PCSYS A/S

The reason why this extra step has been implemented is that this operation will delete everything
related to this machine. This will be tasks, activities, records of consumption, used  man hours etc.
Use this functionality with care!

To delete multiple machines in one operation you can select these by clicking one record, hold shift
and then click the last record you want to delete. Then do the steps above.

You can also hold CTRL and click the records you want to delete one at a time.



38 PCSYS Maintenance 5

© 2010 PCSYS A/S

2.3.1.6 Search for a Machine

To perform a search you need to know one of the following about the machine you are looking for:
Machine Number, Machine Name or ID Code.

To search for a machine do one of the following:

1) File -> Search
2) Right click and click "Search"
3) CTRL + Q

Then you will get this form
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Enter the value for any of the following: Machine Number, Machine Name or ID Code and click
Search.

You will see the search results in the results grid. Click OK to return to the machines tab. You will
be taken back to the Machines Tab where the search result you selected is highlighted.

Note: You can only search for machine that are present in the Location selected in the Location
Pane. If the machine being searched for is not present in the selected Location, it will not show up in
the search results. 

2.3.1.7 Machines Sub Tabs

The seven sub tabs of machines are discussed in this section.
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2.3.1.7.1  Details Sub Tab

The Details Sub Tab shows you the Machine Note, Capacity, Power, Status (Active or Inactive),
Measured Parameter and the Custom Field Group used by the Machine.

The Details Sub Tab of Machine

You can find out more about Measured Parameters by reading Measured Parameters. 
You can find instructions on how to create Custom Field Groups by reading Custom Field Groups.

2.3.1.7.2  Tasks Sub Tab

The Tasks Sub Tab shows the Tasks that have been created for the machine. 

Here, you can create a new Task [New Task], delete a Task [Delete Task] or view the selected Task
in the Tasks Tab [Go To Task]. 

The Tasks Sub Tab of Machine

The advantage of creating tasks through this tab is that it automatically assign the created task to
the highlighted or chosen machine in the main grid.
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The Tasks Sub Tab of Machine - Showing the association of machine name in the main grid to the task
form when initiated through the Tasks Sub Tab

You can find out more about Tasks by reading the Task section.

2.3.1.7.3  Activities Sub Tab

The Activities Sub Tab shows the Activities that have been performed and the Activities scheduled to
be performed for the selected machine. Here, you can see which Activities used Spare Parts
[Consumption, Spare Parts]. The [Consumption, Spare Parts] button gives you an overview of all
used spare parts for this particular machine.

The Activities Sub Tab of Machine

You can also view the selected Activity of the machine in the Activities / Faults Tab [Go To Activity].

To learn more about Activities, click here.
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2.3.1.7.4  Spare Parts Sub Tab

The Spare Parts Sub Tab shows the Spare Parts associated to a Machine. Here, you can associate
a Spare Part [Associate Spare Part], edit its association [Edit Association] or remove its
association [Remove Association]. You can also see which Spare Parts were used while performing
an Activity [Consumption, Spare Parts] and you can view the selected Spare Part in the Spare Parts
Tab [Go To Spare Part].

The Spare Parts Sub Tab of Machine

To associate multiple spare parts in one operation you can select these by clicking one record, hold
shift and then click the last record you want to associate. Enter the Quantity then click Save.
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You can also hold CTRL and click the records you want to associate one at a time.
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You can also associate specific spare parts to the machine by using the Filters in the Machine
Spare Part Association form.
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It is important to note that when attempting to associate a specific Spare Part to a Machine, the list
of Stores displayed for the selected Spare Part is filtered by what is available in the current Location.

You can learn more about Spare Parts by reading Spare Parts.

2.3.1.7.5  Faults Sub Tab

The Faults Sub Tab shows the Faults that have been created for the selected machine. Here, you
can create a new Fault [New Fault], delete a Fault [Delete Fault] and view the selected Fault in the
Activities / Faults Tab [Go to Fault]. You can also see which Faults used Spare Parts
[Consumption, Spare Parts].
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The Faults Sub Tab of Machine

You can learn more about Faults by reading Faults.

2.3.1.7.6  Stop Sub Tab

The Stop Sub Tab shows the Stops that have been created for the selected Machine. Here, you can
delete a Stop [Delete Fault] and view the selected Stop in the Stop Sub Tab of the Activities / Faults
Tab [Go to Stop]. 

The Stop Sub Tab of Machine

You can learn more about Stops by reading Stops.
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2.3.1.7.7  Attachments Sub Tab

The Attachments Sub Tab shows the files or WWW links attached to the selected Machine.

The Attachments Sub Tab of Machine

You can learn more about Attachments in Attachments.

2.3.2 Tasks

The tasks pane shows you the task definitions for the machines.The list is per default limited to the
machines located in the location you have chosen in the location tree as on the machines pane.
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In PM5, a task is a description of the activities needed to perform preventive maintenance on a
machine. It can be the changing of oil, replacement of batteries, cleaning of filters, and so forth.
When creating a task, you will be able to specify the machine for which the activities will be
performed and how often the activities should be performed.
Tasks and Activities are inextricably linked so whenever you create a Task, you will also be creating
the first Activity.
An activity is a record of a moment in time in the progress of a task. If you look at an activity, you
will see the scheduled date of when the activity is supposed to be performed and whether it has
already been performed.
When creating a task, you can specify how often the service should be performed. When creating an
activity for the first time, you specify what date the first service is to be performed.
The Tasks Tab has six sub tabs: Details, Activities, Spare Parts, Calibration – Definition, Calibration
 History and Attachments. You can find more information about each sub tab by reading the Tasks

Sub Tab section.

2.3.2.1 Task Fields

When you create a spare part, you will be shown a set of fields. Each field is explained below.

Note: You can only select values in the Machine, Type of Task, To Be Signed By and Technical
Group fields. If you want to add, edit or delete values in Machine, Type of Task, To Be Signed By
and Technical Group, please click on their underlined names in the image.
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Task Name - the name of the task.
Active Checkbox - a task can be marked as active or not active (no mark). Learn more here.
Machine - the machine for which the activities will be performed. A task cannot be saved without a
reference to a machine.
Type of Task - the task's type.
To Be Signed By - refers to the person who will sign the task once set to done.
Technical Group - refers to the technical group who should perform the task.
Priority - may contain any value. The value entered in Priority becomes the default value in all
Activities recorded by the Task. Activities can be sorted using Priority.
Estimated Manhours - the estimated total amount of uninterrupted labor required to perform a task.
The button for this can only be enabled upon clicking the Apply button and selecting the first activity
date. Learn more here.
Locked Checkbox - a check in "locked" means that even if the activity is performed before or after
the scheduled date, the new activity will be planned according to the original planned date.
Days - the interval of days between each activity planned for this task.
Measured Unit - this field can only be seen if the associated machine is using a measured value.
Measured unit is used in calculating the next activity date of a machine using  a measured
parameter.
Task Note - in this field you can note down other information regarding the task. 

2.3.2.1.1  Active Checkbox

Active Checkbox - a task can be marked as active or not active (no mark).
 Active task - if the task is active, PM5 will automatically plan a new activity, as soon as a planned

activity has been completed. The new activity will be scheduled according to the description of the
task. This way, any active task will have exactly one planned activity.
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 Passive task - if no value is specified in the Days field of Task, PM5 will define this task as
Passive. The lack of this information makes it impossible for PM5 to schedule the next activity.
PM5 will therefore remove the check mark for “Active” and inform the user about this.

Message to appear when task was set as Inactive

Alternatively, an active task can also be made passive by removing the check mark in the Active
checkbox. 

PM5 will then ask you if you want to perform the task for the last time.

A task made passive, has been suggested to be scheduled once more.

If you choose "Yes", you will be asked for the date of the last activity.

The date for last activity should be given
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2.3.2.2 Create Task

To create a task you can do one of the following.

1) CTRL+N
2) Right click and click "New..."
3) File -> New...

Then you will get this form.

1) Give the task a name.
2) Select the machine.
3) Select the type of task (see how to define types here).
4) Select who should sign this task.
5) Select the technical group that should perform this task.
6) Set which priority this task should have.
7) You can specify the manpower resources of this task by clicking the icon beside the estimated

man hours field.
8) Enter how many days there should be between each activity planned for this task.
9) Enter a describing text for the task.
10) Click Save.

You will then be asked if you want to associate/transfer spare parts to the task.
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Upon choosing 'Yes', the Associate Spare Part form will be displayed. If the task's machine has
spare part associated to it already, you can either select from the machine's list of spare part or from
the global list. Just uncheck the 'Show machine spare parts only' to show the spare parts from the
global list.
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11) Select the spare part/s and enter the Quantity to be consumed.
12) You may/may not select a store.
13) Click 'Save' and close the form.

You will then be asked to choose the date for the first planned activity.



54 PCSYS Maintenance 5

© 2010 PCSYS A/S

 
Note: Task Name, Machine, and Type of Task are required fields. You cannot save a Task if the
required fields are empty. All other fields are optional.

2.3.2.3 Edit Task

To edit a task, select the task you want to edit and can do one of the following.

1) Push "Enter"
2) CTRL + E
3) Right click and click "Edit..."
4) File -> Edit

Then you will get this form.
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Change the details of the Task that you want to change and click Save. 

Note: Starting with v5.06, timestamp has been added in the task form. Timestamp is the stored
date/time of creation or modification of a file. 



56 PCSYS Maintenance 5

© 2010 PCSYS A/S

The Task form - Showing the Timestamp of the task

Timestamp contains the details of who created the task, when it was created, who modified the task
and when was it modified.

2.3.2.4 Copy Task

To make it easier for you to create several tasks of the same type with the same spare-parts etc.
PM5 can copy an existing task. To do this do one of the following.

1) File -> Create copy...
2) Right click and choose "Create copy..."
3) ALT+F, C

After you have made the modifications to the task info and click save, if the task has existing spare
parts association, you will be asked if you want to copy the association of spare parts from the
original task.
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If the original task has existing attachments, you will be asked if you want to copy also the
attachments for this task
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Then you will be asked for the date of the first activity. If you choose to close this window the task
will still be created but no activities will be made.



59Client Application

© 2010 PCSYS A/S

Note: You are required to change one of the following: Task Name, Machine, or Type of Task to
successfully create a copy of a Task.

2.3.2.5 Delete Task

To delete a task, select the task and do one of the following

1) CTRL+D
2) Right click and click "Delete"
3) File -> Delete

You will be asked if you want to continue this operation. Mark the check box and click Yes.

The reason why this extra step has been implemented is that this operation will delete everything
related to this task. This will be activities, records of consumption, used  man hours etc. Use this
functionality with care!

To delete multiple tasks in one operation you can select these by clicking one record, hold shift and
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the click the last record you want to delete. Then do the steps above.

You can also hold CTRL and click the records you want to delete one at a time.
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2.3.2.6 Search for a Task

To search for a Task you need to know one of the following about the Task you are looking for: Task
Name, Task Type, Machine Name or Signed By.

To search for a task do one of the following:

1) File -> Search
2) Right click and click "Search"
3) CTRL + Q

Then you will get this form

Enter the value for any of the following: Task Name, Task Type, Machine Name or Signed By and
click Search.
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You will see the search results in the results grid. Click OK to return to the tasks tab. You will be
taken back to the Tasks Tab where the search result you selected is highlighted.

Note: You can only search for Tasks that are present in the Location selected in the Location Pane.
If the Task being searched for is not present in the selected Location, it will not show up in the
search results.

2.3.2.7 Manpower Resources

In PM5, you can specify who will perform a task or a fault by setting its Manpower Resources. When
you specify who performs a task, you are also setting the Manpower Resources of its activities.

Manpower Resources are the members of a Technical Group you want to assign to a Task or Fault.
The selected members are the ones given the responsibility of performing the work required to
complete a Task or Fault.

The modification of technical group is done in the administration module of PM5. To learn more
about Technical Group, click here.

In task, there are two ways on how to specify its manpower resources.

First, through the task form (see Create Task for instructions).

Second, through the task's details sub tab Set Resources button.
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Manpower Resources in the Task's Details Sub Tab

While in fault, the specification of its manpower resources is done through the fault form.

Manpower Resources in the Fault form

Assigning Manpower Resources:

The following steps show you how to use Manpower Resources in tasks and in faults. 

1) When the Use of Man Power form is shown, click on the drop down button under User ID.
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2) Select from the list and enter value in the Estimated Manhours field.
3) You can add people in the list by checking the Include Other Technical Groups checkbox and

Include other locations checkbox.

4) Click the Add button if you want to assign more resources.
5) Click Save.

When you close the form, you will see its total number of estimated manhours.
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Adjusting the Used Manhours:

When an activity or fault is done or solved, you can update its used manhours. To update the Used
Manhours of activity or fault, follow the following steps.

1) Select the activity of the task or select the fault with manhours assigned to it.
2) Open the form.
3) Click on the button beside the Used Manhours box.

4) Observe that the persons you selected in the task or fault form was added to the list of people
assigned to work on the Task or Fault.

5) Enter the number of manhours used for each manpower resources. The date refers to when that
manhour was used by the assigned person.

6) You can add other manpower resources that was not initially assigned to perform the task or fault
but got involved in the process.
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7) Click Save.

2.3.2.8 Tasks Sub Tabs

The six sub tabs of tasks are discussed in this section.

2.3.2.8.1  Details Sub Tab

The Details Sub Tab shows you the Task Note, Task's Status (Active or Inactive), Man Hours
(Manpower Resources), Maintenance Interval, Maintenance Dates and the Custom Field Group used
by the Task.
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The Details Sub Tab of Task

The Maintenance Dates give you the dates of the latest done and next planned activity. They cannot
be changed from here, as they are information on activities.

You can find out more about Manpower Resources by reading Manpower Resources.
You can find instructions on how to create Custom Field Groups by reading Custom Field Groups.

2.3.2.8.2  Activities Sub Tab

The Activities Sub Tab shows you all the activities of the task. It lists the finished and unfinished
activities as well as when the selected Task has been performed and when it is scheduled to be
performed. Here, you can see which Activities used Spare Parts [Consumption, Spare Parts] and
you can also view the selected Activity in the Activities / Faults Tab [Go To Activity].

The Activities Sub Tab of Task

You can learn more about Activities by reading Activities.
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2.3.2.8.3  Spare Parts Sub Tab

The Spare Parts Sub Tab shows the Spare Parts associated to a Task. Here, you can associate a
Spare Part [Associate Spare Part], edit its association [Edit Association] or remove its association
[Remove Association]. You can also see which Spare Parts were used while performing an Activity
[Consumption, Spare Parts]. 

Note that this association is different from the association of spare parts  to machines. When a task
has  been  completed,  PM5 can  take  note  of  the  quantity  of  spare  part  used  for  that  activity  (see
Activities and Faults - Spare Part Sub Tab).

The Spare Parts Sub Tab of Task

To associate multiple spare parts in one operation you can select these by clicking one record, hold
shift and then click the last record you want to associate. Enter the Quantity then click Save.
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You can also hold CTRL and click the records you want to associate one at a time.



70 PCSYS Maintenance 5

© 2010 PCSYS A/S

You can also associate specific spare parts to the task by using the Filters in the Associate Spare
Part form.
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It is important to note that when attempting to associate a specific Spare Part to a Task, the list of
Stores displayed for the selected Spare Part is filtered by what is available in the current Location.

You can learn more about Spare Parts by reading Spare Parts.

2.3.2.8.4  Calibration

Calibration is useful for taking counter readings every time an activity is done.

The Calibration Tab in Tasks is divided into two Sub Tabs - Definition and History. Definition is where
you can enter calibration Data and History is where you can view a historical log of calibration Data.
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Under the Definition Sub Tab, you can select a Calibration Group (in the dropdown box beside Group
Name) and enter data for the Fields in the selected Calibration Group. You will be able to see the
same data you entered in Definition when you go to any Activity of the Task in the Activities / Faults
Tab and take look at the Calibration Sub Tab. This serves as a reference.

Under the History Sub Tab, you can see a list of Calibration readings. If, in the Definition Sub Tab, a
Calibration Group’s "Reading" box is checked, you may enter values in the Reading Sub Tab of the
Activity in the Activities / Faults Tab.

For example, let’s say you have an Task called "Delivery" and its Calibration Group has a field called
"Distance Covered" and its Reading box is checked, when you go to the Activity called “Delivery” in
the Activities / Faults Tab and click on the Reading Sub Tab, you will be able to enter a value for
Distance Covered.

2.3.2.8.5  Calibration - Definition Sub Tab

To learn how to create Calibration Groups in PM5, click here.

The Calibration – Definition Sub Tab is where you can enter calibration Data. The following example
illustrates how to use Calibration Groups.

1) In the Tasks tab of PM5, select the task in which you want to use a calibration group.
2) Click on the Calibration Sub Tab of the task, click on the Definition Sub Tab and choose the name

of the calibration group you want to use.

Calibration - Showing how to assign a calibration group to a task

3) Enter values in the respective fields of the selected calibration group.

Calibration - Showing entered values for fields of a calibration group
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4) In the Activities sub tab of the task, select and double click the activity that is to be set to done.
This will bring you to Activities / Faults Tab of PM5.

5) While the activity is selected, click on its Calibration sub tab.

Calibration - Showing the calibration sub tab of an activity

To learn more about Calibration sub tab of an Activity, click here.

6) Enter the reading values of the activity for the calibration group in the Reading pane of calibration
sub tab.

Calibration - Showing entered values for Reading pane of activity's calibration sub tab

7) Double click the activity. This will open the Activities window. Check the box labeled “Done” and
click Save. You will see a message that says “A new activity is scheduled: XX/XX/XXX,” where the
Xs stand for the scheduled date of the next activity. Click OK to close this message.
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Calibration - Setting the activity to done

8) Once the activity was set to done, a new activity should be created if the task is active.

2.3.2.8.6  Calibration - History Sub Tab

The Calibration – History Sub Tab is where you can view a historical log of calibration Data. It shows
the data you entered in Reading pane when you go to any Activity of the Task in the Activities /
Faults Tab. This serves as a reference.
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2.3.2.8.7  Attachments Sub Tab

The Attachments Sub Tab shows the files or WWW links attached to the selected Task.

The Attachments Sub Tab of Tasks

You can learn more about Attachments in Attachments.

2.3.3 Spare Parts

This pane shows the spare parts defined in the system. These spare parts can be assigned to
machines, tasks and activities. You can also assign store locations to your spare parts and get
extended functionality like stock keeping, definition when re-ordering for stock and more. This
section will guide you through all the functionality.

In PM5, a spare part is anything that can be used to replace a broken or worn out component of a
machine.
The Spare Parts Tab has seven sub tabs: Details, Machines, Consumptions – Activities,
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Consumptions – Faults, Stores, Suppliers and Attachments. You can find more information about
each sub tab by reading the Spare Parts Sub Tab section.

2.3.3.1 Spare Parts Fields

When you create a spare part, you will be shown a set of fields. Each field is explained below.

Note: You can only select values in the Group and Manufacturer Name fields. If you want to add,
edit or delete values in Group and Manufacturer Name, please click on their underlined names in the
image.

The Create New Spare Part Window

Spare Part Number - the unique identifier for a spare part, hence one of the required fields to fill out
to be able to save a spare part.
Type Number - similar to machine, this field serves as an alternative way to identify a spare part.
Spare Part Name - the name of the spare part.
Spare Part Note - in this field you can note down other information regarding the spare part. 
Dimension - measurement in length, width, thickness, etc. of the spare part.
Group - the group where the spare part belongs to.
Manufacturer Name - the producer or maker of the machine.
Bar Code - the barcode data of spare part.
Unit - the unit used to measure the amount or quantity of spare parts.
Cost Price - the price of the spare part.
Allocate to Stock - means that you are placing the spare part into a new location in stock.
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Note: You can click on the link of the image above for further information.

Store - the location of stock.
Stock Area - used to define the specific storage area of spare part.
Stock Section - used to define the specific storage section of spare part.
Stock Position - used to define the specific storage position of spare part.
Inventory - sum of all spare parts that are available .
Minimum on Stock - the expected minimum value of spare parts in stock.
Quantity to Order - the number of spare parts to order.
Preferred Store - if you mark the store as the preferred store for a particular spare part then it will
be the default suggested store when associating to tasks, activities etc.

2.3.3.2 Create Spare Part

To create a spare part you can do one of three things:

1) File -> New...
2) CTRL + N
3) Right click the grid and select "New..."

Then you will get this form.
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1) Enter the spare part number.
2) Put the type number of the spare part.
3) Give the spare part a name.
4) Enter a describing text for the spare part.
5) Enter the dimension of the spare part.
6) Select the group of the spare part.
7) Select the manufacturer of the spare part.
8) If there is any, enter the barcode data of the spare part.
9) Enter the unit for the spare part.
10)  Finally, enter the cost price of the spare part.

Note: Spare Part Number, Spare Part Name and Group are required fields. You cannot save a Spare
Part if the required fields are empty.All other fields are optional.

Allocating the spare part to a stock can be done at a later time. But it's always up to you how you
like to manage PM5.

If you want to allocate allocate the spare part to a store location before saving, click the "Allocate to
Stock" and you will get the following form.



79Client Application

© 2010 PCSYS A/S

1) Select the store of the spare part.
2) Enter the corresponding values for the store labels.
3) Enter the value for inventory.
4) Enter the value for minimum on stock.
5) Enter the value for quantity to order.
6) Decide wether the store will be the preferred store or not.
7) Click save.

Note: Store, Inventory, Minimum on Stock and Quantity to Order are required fields for stock
allocation. You cannot save a Stock if the required fields are empty. All other fields are optional.

2.3.3.3 Edit Spare Part

To edit a spare part, select the spare part you want to edit and do one of the following:

1) Push "Enter"
2) CTRL + E
3) Right click and click "Edit..."
4) File -> Edit

Then you will get this form.
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Change the details of the Spare Part that you want to change and click Save. 

2.3.3.4 Copy Spare Part

To make it easier for you to create several spare parts of the same type. PM5 can copy an existing
spare part. To do this do the following.

1) File -> Create copy...
2) Right click and choose "Create copy..."
3) ALT+F, C

After you have made the modifications to the spare part info and click save, if the task has existing
attachments, you will be asked if you want to copy the attachments of spare parts from the original
spare part.
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Note: You are required to change the Spare Part Number when making a copy of a Spare Part.

2.3.3.5 Delete Spare Part

The are a few scenarios that disables you from deleting a spare part. If the spare part have any
associations (machines, tasks, etc.) and have or have no store location with positive stock, this
would require you to have the Delete Spare Part Privilege. To learn about privileges, click here.

However, if the spare part has no current associations but with store locations with positive stocks, 
you will have to adjust the stock first before you can delete the spare part. An error  message will
appear to if you attempted to delete the spare part with positive stock allocation.

Error message when deleting a Spare Part with positive Stock

To delete a spare part, select the spare part and do one of the following

1) CTRL+D
2) Right click and click "Delete"
3) File -> Delete
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The reason why this extra step has been implemented is that this operation will delete all
associations related to the spare part. Use this functionality with care!

To delete multiple spare parts in one operation you can select these by clicking one record, hold
shift and the click the last record you want to delete. Then do the steps above.

You can also hold CTRL and click the records you want to delete one at a time.

Note: Deleted spare parts with associations are set to Inactive status only, while on the other hand
deleted spare parts without associations gets deleted permanently.
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2.3.3.6 Merge Spare Parts

The use of this functionality requires to have the Merge Spare Parts Privilege of the User Group
where the user belongs to. To learn how to assign privileges to a User Group, click here.

Merge of Spare Parts means to merge or combine one spare part with another together with its
association to machines, tasks, stores and attachments. When two spare pats are merged, source
spare part is set to inactive and all its machines, tasks, stores and attachments association will be
combined with the associations of destination spare part. To understand better, take a look at the
example below.

Using the demo database, we get the spare parts BJ-Snekkegear and Magnetvent Festo with spare
part number 932L9363. Magnetvent Festo spare part is to be merged to BJ-Snekkegear spare part,
which also means that Magnetvent Festo will be our source spare part and BJ-Snekkegear will be
the destination spare part.

Take note that Magnetvent Festo has existing machine associations while BJ-Snekkegear do not
have. To merge the spare parts, right click on the source spare part and click Merge/Replace Spare
Parts.
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After clicking from the menu, the Merge/Replace Spare Part form will appear.
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Select the destination spare part in the list, which in our case is the BJ-Snekkegear. You can use
the filter in the form for easy searching.

Upon selecting the destination spare part, click on the [Merge to] button at the left side of the form
then click OK in the confirmation message.
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Confirmation message before merging the spare parts

A message box will appear if the Merging is successful.

Information message when Merging of Spare Part is successful

Going back to our example, after the merging, Magnetvent Festo should be set to Inactive and all its
machines, tasks, stores and attachments associations should be merged to BJ-Snekkegear's
associations.

Spare Part BJ-Snekkegear showing the merged Machine associations from Magnetvent Festo and
Magnetvent Festo as an Inactive Spare Part

2.3.3.7 Replace Spare Parts

The use of this functionality requires to have the Replace Spare Parts Privilege of the User Group
where the user belongs to. To learn how to assign privileges to a User Group, click here.

Replace of Spare Parts means replacement of one spare part to another with all its associations
(Machines, Tasks and Activities/Faults). To understand better, take a look at the example below.

Using the demo database, we get the spare parts Bosch Magnetvent and Lamp. Lamp spare part is
to be replaced by Bosch Magnetvent spare part, which also means that Lamp will be our source
spare part and Bosch Magnetvent will be the destination spare part.
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Take note that Lamp has existing machine associations while Bosch Magnetvent do not have. To
merge the spare parts, right click on the source spare part and click Merge/Replace Spare Parts.

After clicking from the menu, the Merge/Replace Spare Part form will appear.
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Select the destination spare part in the list, which in our case is the Bosch Magnetvent. You can
use the filter in the form for easy searching.

Upon selecting the destination spare part, click on the [Replace with] button at the left side of the
form then click OK in the confirmation message.
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Confirmation message before replacing the spare parts

A message box will appear if the Merging is successful.

Information message when Replacing of Spare Part is successful

Going back to our example, after the replacement has taken place, Lamp's associations to
machines, tasks and activities/faults should be transferred to Bosch Magnetvent.

Lamp's machine association was transferred to Bosch Magnetvent after the replacement

Note: Replacing of spare parts can only be done at locations that are accessible to the user.
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2.3.3.8 Search for a Spare Part

To search for a Spare Part you need to know one of the following about the Spare Part you are
looking for: Spare Part Number, Spare Part Name, Dimension, Type Number or Bar Code.

To search for a task do one of the following:

1) File -> Search
2) Right click and click "Search"
3) CTRL + Q

Then you will get this form

Enter the value for any of the following: Spare Part Number, Spare Part Name, Dimension, Type
Number or Bar Code and click Search.
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You will see the search results in the results grid. Click OK to return to the spare parts tab. You will
be taken back to the Spare Parts Tab where the search result you selected is highlighted.

2.3.3.9 Spare Parts Sub Tab

The seven sub tabs of spare part are discussed in this section.

2.3.3.9.1  Details Sub Tab

The Details Sub Tab shows you the Spare Part Note, Dimension, Bar Code, Unit, Cost Price and the
Custom Field Group used by the Spare Part.

The Details Sub Tab of Spare Part
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Note: A created spare part is automatically specified to be Object in Store.

You can find instructions on how to create Custom Field Groups by reading Custom Field Groups.

2.3.3.9.2  Machines Sub Tab

In the Machines Sub Tab of the Spare Parts Tab, you can associate Machines to Spare Parts.
Associating a Machine to a Spare Part allows you to keep track of which Machines use which Spare
Parts.

The Machines Sub Tab of Spare Parts

It is important to know that the Machines you will see in the Associate Machine Window depend on
the Location selected in the Location Pane. If you select the root location you will see all the
Machines. However, if you select a specific Location, you will see only the Machines that are
available in that Location.

The relationship of the Location pane to the list of machines in the Associate Machine form of Spare
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Parts

To associate multiple machines in one operation you can select these by clicking one record, hold
shift and then click the last record you want to associate. Enter the Quantity then click Save.

You can also hold CTRL and click the records you want to associate one at a time.
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You can also associate specific machines to the task by using the Filters in the Associate Machine
form.
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2.3.3.9.3  Consumptions - Activities Sub Tab

The Consumptions - Activities Sub Tab shows the Spare Parts that have been consumed and are
scheduled to be consumed by Activities. Spare Parts that have not yet been consumed but are
scheduled to be consumed appear in blue text with a gray background. Here, you can jump directly
to the Task, Machine or Activity that consumed or is scheduled to consume the selected Spare Part
by clicking the appropriate Go To Button.



96 PCSYS Maintenance 5

© 2010 PCSYS A/S

The Consumptions - Activities Sub Tab of Spare Part

2.3.3.9.4  Consumptions - Faults Sub Tab

The Consumptions - Faults Sub Tab shows the Spare Parts that have been consumed by Faults.
Here, you can jump directly to the Machine or Fault that consumed the selected Spare Part by
clicking the appropriate Go To Button.

The Consumptions - Faults Sub Tab of Spare Parts

2.3.3.9.5  Stores Sub Tab

The Stores Sub Tab shows all the Stores in which the Spare Part is available. Here you can allocate
a spare part to a store [Allocate to Stock], edit the allocation [Edit Allocation] and remove the
allocation [Remove Allocation].

The columns I, II and III represent the Area, Section and Position of the Store defined in the
Administration Tool. These will appear when you Allocate or Edit the Allocation of a Spare Part.

The Stores Sub Tab of Spare Part

[Allocate to Stock] - put a spare part into a new location in stock.

[Edit Allocation]  - edit  the quantity on a previously  used  location. This  way  you  can  increase  your
stock when new deliveries arrive.

[Remove Allocation] - remove the allocation of stock.

It is important to note that when allocating a spare part to a stock, the list of Stores is filtered by
Locations accessible to the user. To learn more about assigning stores to locations, click here.
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2.3.3.9.6  Suppliers Sub Tab

The Suppliers Sub Tab shows the Suppliers associated to a Spare Part. Here, you can associate a
Supplier [Associate Supplier], edit its association [Edit Association] or remove its association
[Remove Association]. You can also view the selected Supplier in the Suppliers Tab [Go To
Supplier].

The Suppliers Sub Tab of Spare Part

You can learn more about Suppliers by reading Suppliers.

2.3.3.9.7  Attachments Sub Tab

The Attachments Sub Tab shows the files or WWW links attached to the selected Spare Part.

The Attachments Sub Tab of Tasks

You can learn more about Attachments in Attachments.
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2.3.4 Suppliers

This pane shows all the suppliers available in the system. These suppliers can be assigned to spare
parts and will then be used when ordering to specify spare part number, pricing etc.

In PM5, a Supplier is the source of a Machine. 
When you create a Supplier, you can also specify its contact information. If contact information for a
Supplier is defined, you can use PM5 as an electronic phone and address book.
The Suppliers Tab has four sub tabs: Details, Machines, Spare Parts and Attachments. You can find
more information about each sub tab by reading the Suppliers Sub Tab section.

2.3.4.1 Supplier Fields

When you create a spare part, you will be shown a set of fields. Each field is explained below.

Note: You can only select values in the Country, Zip Code and Phone Types fields. If you want to
add, edit or delete values in Country, Zip Code and Phone Types, please click on their underlined
names in the image.
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Supplier Number - the unique identifier for a supplier, hence one of the required fields to fill out to
be able to save a supplier.
Country - the country of the supplier.
Supplier Name - the name of the supplier.
Address - place of business where it can be contacted.
Zip Code - the postal code of the supplier. This can be set automatically by selecting the City.
City - the city where the supplier resides.
Telephone - the phone number of the supplier.
Fax - the fax number of the supplier.
Note - in this field you can note down other information regarding the supplier.
Telephone Numbers - in this field, you can specify other contact details of the supplier.
Contacts - in this field, you can specify the contact persons of the supplier.

2.3.4.2 Create Supplier

To create a supplier you can do one of three things:

1) File -> New...
2) CTRL + N
3) Right click the grid and select "New..."

Then you will get this form.
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1) Enter the supplier number.
2) Select the country of the supplier.
3) Enter the supplier name.
4) Enter the contact information of the supplier.
5) Provide a describing text for the supplier.
6) Enter other details for the supplier.
7) Click save.

Note: Supplier Number and Supplier Name are required fields. You cannot save a Supplier if the
required fields are empty.

2.3.4.3 Edit Supplier

To edit a supplier, select the supplier you want to edit and do one of the following:

1) Push "Enter"
2) CTRL + E
3) Right click and click "Edit..."
4) File -> Edit

Then you will get this form.
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Change the details of the Supplier that you want to change and click Save. 

2.3.4.4 Delete Supplier

To delete a supplier, select the supplier and do one of the following

1) CTRL+D
2) Right click and click "Delete"
3) File -> Delete

Supplier was not deleted because of related records

The are a few scenarios that disables you from deleting a supplier. If you have any associated
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machines, you will have to remove these manually before you can delete the supplier.

If the supplier does not have any machine associations, you will be asked if you want to continue
this operation. Mark the check box and click Yes.

The reason why this extra step has been implemented is that this operation will delete its
association to a spare part. Use this functionality with care!

To delete multiple suppliers in one operation you can select these by clicking one record, hold shift
and the click the last record you want to delete. Then do the steps above.

You can also hold CTRL and click the records you want to delete one at a time.
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2.3.4.5 Search for a Supplier

To perform a search, you need to know one of the following about the Supplier you are looking for:
Supplier Number or Supplier Name.

To search for a task do one of the following:

1) File -> Search
2) Right click and click "Search"
3) CTRL + Q

Then you will get this form

Enter the value for any of the following: Supplier Number or Supplier Name and click Search.
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You will see the search results in the results grid. Click OK to return to the suppliers tab. You will be
taken back to the Suppliers Tab where the search result you selected is highlighted.

2.3.4.6 Supplier Sub Tabs

The four sub tabs of supplier are discussed in this section.
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2.3.4.6.1  Details Sub Tab

The Details Sub Tab shows you the Supplier Note, Telephone Numbers, Contacts, Email and the
Custom Field Group used by the Supplier.

The Details Sub Tab of Supplier

You can find instructions on how to create Custom Field Groups by reading Custom Field Groups.

2.3.4.6.2  Machines Sub Tab

The Machines Sub Tab shows you the Machines supplied by the selected Supplier. Here, you can
view the selected Machine in the Machines Tab [Go To Machine].

The Machines Sub Tab of Supplier

To learn how to assign supplier to a machine read about Machines.
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2.3.4.6.3  Spare Parts Sub Tab

The Spare Parts Sub Tab shows you the Spare Parts associated to the selected Supplier. Here, you
can associate a Spare Part [Associate Spare Part], edit its association [Edit Association] or remove
its association [Remove Association].

The Spare Parts Sub Tab of Supplier

You can associate specific spare parts to the machine by using the Filters in the Supplier Spare
Part Association form. Enter the Price then click Save.
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2.3.4.6.4  Attachments Sub Tab

The Attachments Sub Tab shows the files or WWW links attached to the selected Supplier.

The Attachments Sub Tab of Machine

You can learn more about Attachments in Attachments.

2.3.5 Activities and Faults

The Activities/Faults tab is used to get an overview of the tasks in the past and future. In this grid
you can easily see how many open, overdue, done tasks you have.

2.3.5.1 Activities

The activities are generated from the tasks specified on the machines. Depending on interval and
other parameters these will be generated automatically when an activity is marked as done. Click 
here to read about specifying tasks for machines.
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An Activity is a record of the progress of a Task. It shows you who performed the task, when it was
performed and when it will be performed again.
In the Activities / Faults Tab, you can distinguish an Activity by looking at its Fault box. If the box is
clear, it is an Activity.

When you select an Activity, you will see five sub tabs: Details, Spare Parts, Calibration,
Attachments and Task - Attachments. You can find more information about each sub tab by reading
the Activities Sub Tabs section.

2.3.5.1.1  Activity Fields

When you create a spare part, you will be shown a set of fields. Each field is explained below.

Note: You can only select values in the Signed By field. If you want to add, edit or delete values in
To Be Signed By, please click on their underlined names in the image.

Signed By - the person who signed the activity. To add persons in the list, click on the link of the
image above.
To Be Signed By - the person who was initially assigned to sign the task. The value for this is
assigned through the task form. To learn how to assign value, click here.
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Job No. - the id or job number of the activity. This is automatically generated by PM5.
Priority - the priority number of the activity. Entering a value for Priority in an Activity allows you to
sort Activities using the Priority field. Changing the value of priority in the Activity form will not affect
the value of Priority in the Activity’s parent Task.
Done Checkbox - when the Done box is checked it means the Activity is completely finished.
Checking the Done box requires you to select a date for Activity Done and will cause a new activity
to be scheduled on a future date (if the Task is Active). Learn more here.
Started Checkbox - when the Started is checked, it means work has started on the activity but it is
not yet completely finished. Checking the Started box requires you to select a date for Expected
End Date.
Fixed Date - When the Fixed Date box is checked it means that the Date cannot be overridden.
Checking the Fixed Date box makes sure that the Activity is performed only on the specified date - it
cannot be overridden by the interval (number of days) or even by calculations of the next activity date
by the OPC.
Date Scheduled - the scheduled date for the activity.
Activity Done - the date when the activity was set to done or finished.
Expected End Date - this field is used when the activity has started. This field sets the expected
end or done date of the activity.
Used Man Hours - the total amount of uninterrupted labor used to perform the task. Learn more here
.
Activity Note - in this field you can note down other information regarding the activity.

The other fields that are not editable are used for easy reference on the machine and task where the
activity is assigned.

2.3.5.1.2  Create Activity

There are three ways to create an Activity.

First, you can create a new Task (see Create Task for instructions) and with the creation of that task
you automatically create an Activity.

Second is to mark an Activity as “Done.” Once you mark an Activity as “Done” and save it, a new
Activity will be created.

The third way applies to passive Tasks, which are tasks that are not marked as “Active.”
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When a Task is not marked as “Active” and all of its Activities are marked as “Done” or it has zero
Activities, you will see a button in the Task form called New Activity.

Clicking on this button opens a window that will ask you to specify the date of the Activity.
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2.3.5.1.3  Edit Activity

To edit an activity, select the activity you want to edit and do one of the following:

1) Push "Enter"
2) CTRL + E
3) Right click and click "Edit..."
4) File -> Edit

Then you will get this form.

Change the details of the activity that you want to change and click Save.

2.3.5.1.4  Copy Activity

To copy an activity you can do one of the following

1) File -> Create copy...
2) Right click and choose "Create copy..."
3) ALT+F, C
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Copied activity is always set to Done Status. The only details that you can change on the activity
are Signed By, Priority, and the Used Manhours. Change the details of the Activity that you want to
change and click Save. If activity has existing spare part associations, you will be asked if you want
to copy also the Spare Parts associated to the original Activity.

If activity has existing attachments, you will be asked if you want to copy also the attachments of
the original activity.

The Activity you copied will appear in bold in the Activities \ Faults Tab.
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2.3.5.1.5  Set Activity to Done

To set an Activity to Done, you must select the Activity first. There are three ways to do this.

First, select the Activity through the Machine's Activities sub tab.

The Machines tab - Showing the Activities Sub Tab

Second is through the Task's Activities sub tab.
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The Tasks tab - Showing the Activities Sub Tab

And lastly, through the Activities tab itself.

The Activities / Faults tab - Showing the list of Activities

Open the Activity and you will get this form.
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1) Mark the Done checkbox.
2) Select value for Signed By.
3) Select the Activity Done date (current date is selected for this field by default).
4) Click Save.

You will then be asked if you want to associate/transfer spare parts to the activity.
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Upon choosing 'Yes', the Associate Spare Part form will be displayed. 
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5) Select the spare parts you wishes to associate to the activity.
6) Enter the Scheduled Quantity.
7) (Optional) Select a Store.
8) Select the Consumption Date and who used it.
9) Decide whether the spare parts are already consumed.
10)Select the Consumption Type from the list.
11)Click Save and close the form.
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You will then be asked for the next activity date. Click the OK button in the form.

2.3.5.1.6  Activity Sub Tabs

The five sub tabs of activity are discussed in this section.
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2.3.5.1.6.1  Details Sub Tab

The Details Sub Tab of an Activity shows the Task Note, Activity Note and Job Number.

The Details Sub Tab of Activity

The Task Note can be changed by editing the parent Task of the Activity, which is the Task used to
create the Activity.
The Activity Note can be changed by editing the Activity.
Clicking on the […] button beside Job Number causes the Activities window to open, which allows
you to edit the selected Activity.
When the Spare Parts box is checked, it means that at least one Spare Part is associated to the
selected Activity. If it is not checked, it means that there are no Spare Parts currently associated to
the selected Activity.
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2.3.5.1.6.2  Spare Parts Sub Tab

The Spare Parts Sub Tab, when an Activity is selected, displays the Spare Parts associated with an
Activity. 

The Spare Parts Sub Tab of Activity

The Spare Parts Sub Tab shows the Spare Parts associated to an Activity. Here, you can associate
a Spare Part [Associate Spare Part], edit its association [Edit Association] or remove its
association [Remove Association]. You can also view the selected Spare Part in the Spare Parts
Tab [Go To Spare Part].

To associate multiple spare parts in one operation you can select these by clicking one record, hold
shift and then click the last record you want to associate. Enter the Scheduled Quantity then click
Save.
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You can also hold CTRL and click the records you want to associate one at a time.
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You can also associate specific spare parts to the task by using the Filters in the Associate Spare
Part form.
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It is important to note that when attempting to associate a specific Spare Part to an Activity, the list
of Stores displayed for the selected Spare Part is filtered by what is available in the current Location.

You can learn more about Spare Parts by reading Spare Parts.

2.3.5.1.6.3  Calibration Sub Tab

The Calibration Sub Tab of Activity is divided into two panes: Definition and Reading.

If the parent Task of the selected Activity is assigned a Calibration Group and if values have been
defined for the Calibration Group, you will see in the Definition pane the same set of values found in
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the Calibration Definition Sub Tab of the parent Task of the selected Activity.

The Reading pane allows you to enter new values in the fields of the Calibration Group.

You can learn more about Calibration by reading Calibration.

2.3.5.1.6.4  Attachments Sub Tab

The Attachments Sub Tab shows the files or WWW links attached to the selected Activity.

The Attachments Sub Tab of Activity

You can learn more about Attachments in Attachments.
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2.3.5.1.6.5  Task - Attachments Sub Tab

The Task - Attachments Sub Tab shows the files or WWW links attached to the Activity's parent
Task.

The Task - Attachments Sub Tab of Activity

To learn how to attach files in Task, click here.

2.3.5.2 Faults

The faults listed in the activities/faults pane are all linked to their corresponding machines. A fault
can be manually generated and reported from the OPC (read about OPC). The faults are indicated in
the grid by a check mark in the "fault column".

A Fault is an error or defect found in a Machine. It gives you a description of what the fault is, when it
occurred and why it occurred.
When you select a Fault, you will see four sub tabs: Details, Spare Parts, Stop and Attachments.
You can find more information about each sub tab by reading the Faults Sub Tabs section.
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2.3.5.2.1  Fault Fields

When you create a spare part, you will be shown a set of fields. Each field is explained below.

Note: You can only select values in the Fault Type, Discovered By, Technical Group, To Be signed
By, Approved By  and Cause Types fields. If you want to add, edit or delete values in Fault Type,
Discovered By, Technical Group, To Be signed By, Approved By  and Cause Types, please click on
their underlined names in the image.

Machine - refers to the machine where the fault was found. You can always change its value since
this field is editable.
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Job No. - the id or job number of the fault. This is automatically generated by PM5.
Fault Type - the type of fault.
Discovered Date - the date when the fault occurred or was found.
Discovered By - the person who discovered the fault. To add persons in the list, click on the link of
the image above. 
Priority - the priority number of the fault. Entering a value for Priority in a fault allows you to sort fault
using the Priority field.
Alarm Code - the error code of the machine. When you know the error code you can often refer this
in the troubleshoot section of the manual of the machine to see how to fix the error.
Technical Group - refers to the technical group who should resolve the fault.
Estimated Manhours - the estimated total amount of uninterrupted labor required to resolve the
fault. Learn more here.
Used Manhours -  the total amount of uninterrupted labor used to resolve the fault. Learn more here.
To Be Signed By - the person who signed the fault. To add persons in the list, click on the link of
the image above
Started Checkbox - when the Started is checked, it means work has started on the fault but it is
not yet completely finished. Checking the Started box requires you to select a date for Expected
End Date.
Expected End Date - the date when the fault is expected to finish.
Approval Required Checkbox - when the Approval Required is checked, it means that the fault
requires to have an approval.
Approved Checkbox - when the Approved is checked, it means that the fault was already
approved. Checking this box requires you to select the person who approved the fault.
Approved By - the person who approved the fault. To be included in this list, user must be belong to
a user group with Approval privilege. 
Solved Checkbox - when the Solved is checked, it means that the fault is already solved. Checking
the Solved box requires you to select the date when it was solved and the cause type. Learn more 
here.
Date Solved - the date when the fault was solved.
Cause Type - the type of cause of the fault. (e.g. mechanical)
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2.3.5.2.2  Create Fault

The creation of faults is done in the machines tab of PM5.

1) To create a fault, go to machines tab. 
2) Select the machine you want to create a fault.
3) Go to Faults Sub Tab.
4) Click New Fault.
5) Select the Fault Type.
6) Select when the fault was discovered.
7) Select who discovered the fault.
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8) (Optional) Set the priority number.
9) (Optional) Enter the alarm code.
10)  Select the technical group that should resolve this fault.
11)  Enter a describing text for the fault.
12)  Assign manpower resources and set the estimated man hours to resolve the fault.
13)  Click Save.

You will then be provided with two options: Add spare parts to fault and Add Stop Period.

Choosing to add spare parts to the fault will result to the following form. If the fault's machine has
spare part associated to it already, you can either select from the machine's list of spare part or from
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the global list. Just uncheck the 'Show machine spare parts only' to show the spare parts from the
global list.

14)Select the spare parts you wishes to associate to the fault.
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15)Enter the Scheduled Quantity.
16)(Optional) Select a Store.
17)Select the Consumption Date and who used it.
18)Decide whether the spare parts are already consumed.
19)Select the Consumption Type from the list.
20)Click Save and close the form.

If you choose to Add Stop Period to the fault, the Stop form will be displayed to you after closing the
Associate Spare Part form.

21)Provide the necessary details and click Save.

Note:  Fault  Type  and  Discovered  By  are  required  fields.  You  cannot  save  a  Fault  if  any  of  the
required fields is empty. All other fields can be filled out at a later time.

2.3.5.2.3  Edit Fault

To edit a fault, select the fault you want to edit and do one of the following:

1) Push "Enter"
2) CTRL + E
3) Right click and click "Edit..."
4) File -> Edit

Then you will get this form.
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Change the details of the Fault that you want to change and click Save. 

2.3.5.2.4  Set Fault to Solved

To set a Fault to Solved, you must select the Fault first. There are two ways to do this.

Select the Fault through the Machine's Faults sub tab
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The Machines tab - Showing the Faults Sub Tab

Or through the Faults tab itself.

The Activities/Faults tab - Showing the list of Faults

Open the Fault for edit.
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1) Mark the Solved checkbox.
2) Select the value for Date Solved (current date is selected for this field by default).
3) Select the Cause Type from the list.
4) Click Save.

Upon clicking Save button, the option of adding spare parts and stop period to the fault will be
provided.
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Choosing to add spare parts to the fault will result to the following form. If the fault's machine has
spare part associated to it already, you can either select from the machine's list of spare part or from
the global list. Just uncheck the 'Show machine spare parts only' to show the spare parts from the
global list.
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1) Select the spare parts you wishes to associate to the fault.
2) Enter the Scheduled Quantity.
3) (Optional) Select a Store.
4) Select the Consumption Date and who used it.
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5) Decide whether the spare parts are already consumed.
6) Select the Consumption Type from the list.
7) Click Save and close the form.

If you choose to Add Stop Period to the fault, the Stop form will be displayed to you after closing the
Associate Spare Part form.

5) Provide the necessary details and click Save.

2.3.5.2.5  Fault Sub Tabs

The four sub tabs of fault are discussed in this section.
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2.3.5.2.5.1  Details Sub Tab

The Details Tab of a Fault shows the Fault Description, Solution and Job Number.

The Details Sub Tab of Fault

When the Spare Parts box is checked, it means that at least one Spare Part is associated to the
selected Fault. If it is not checked, it means that there are no Spare Parts currently associated to
the selected fault.
The Fault Description and Solution can be changed by editing the Fault.
Clicking on the […] button beside Job Number causes the Faults window to open, which allows you
to edit the selected Fault.

2.3.5.2.5.2  Spare Parts Sub Tab

The Spare Parts Sub Tab, when a fault is selected, displays the Spare Parts associated with a
fault. 
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The Spare Parts Sub Tab of Fault

The Spare Parts Sub Tab shows the Spare Parts associated to a Fault. Here, you can associate a
Spare Part [Associate Spare Part], edit its association [Edit Association] or remove its association
[Remove Association]. You can also view the selected Spare Part in the Spare Parts Tab [Go To
Spare Part].

To associate multiple spare parts in one operation you can select these by clicking one record, hold
shift and then click the last record you want to associate. Enter the Scheduled Quantity then click
Save.

You can also hold CTRL and click the records you want to associate one at a time.
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You can also associate specific spare parts to the task by using the Filters in the Associate Spare
Part form.
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It is important to note that when attempting to associate a specific Spare Part to a Fault, the list of
Stores displayed for the selected Spare Part is filtered by what is available in the current Location.

You can learn more about Spare Parts by reading Spare Parts.
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2.3.5.2.5.3  Stop Sub Tab

The Stop Tab shows the Stops created for a Fault. Here, you can create a stop [New Stop] and
delete existing stops [Delete Stop].

The Stop Sub Tab of Fault

You can learn more about Stops by reading Stops.

2.3.5.2.5.4  Attachments Sub Tab

The Attachments Sub Tab shows the files or WWW links attached to the selected fault.

The Attachments Sub Tab of Activity

You can learn more about Attachments in Attachments.

2.3.5.2.6  Stops

A Stop refers to a point in time when a Machine stopped working. It is only possible to create a Stop
for a Machine if a Fault is created first.

In a Stop, you can specify the date and time the Machine stopped working and the date and time
the Machine started working again. In the Stop form, you will also see the Down-Time Group (Stop
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Group) of the Machine, a box that denotes if the Stop is Machine Specific, the duration of the Stop
and a drop down box that allows you to select the Down-Time Type of the Stop.

A Stop Group is a group composed of interdependent Machines. Interdependent means that when
one Machine in the Stop Group stops working, all of the Machines in the Stop Group are affected. 

Stop Groups are created using the Administration tool and are used by Machines. You can find
instructions on how to create a Stop Group here.

2.3.5.2.6.1  Create Stop

On the faults sub grid you can enter one or more stops for the machine connected to the fault. Click
on "new stop" in the sub pane and you will get this form.

You can enter the interval where the stop occurred. If you check the mark "Machine Specific" it
means that other machines in the group where not affected by the stop on this machine and kept
running during the stop. Otherwise the stop will be resulting in reported down time for all machines in
this group.

Last specify the Down-time type which is also used for statistic purposes. The types can be defines 
here.

The Stop created can be seen in the Stop Sub Tab of the fault and in the Stop Sub Tab of the
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Machine the Stop was created for.

2.3.5.2.6.2  Delete Stop

There are two ways to delete a stop.

First, you can delete a stop through the stop sub tab of the machine the stop was created for.

Second is through the stop sub tab of the fault of the machine.
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1) Select the stop that you want to delete and click Delete Stop.
2) Click Yes in the confirmation message.

The stop gets deleted permanently and will no loner appear in the stop sub tabs. 

2.3.5.3 Delete Activity/Fault

To delete an activity/fault, select the activity/fault and do one of the following

1) CTRL+D
2) Right click and click "Delete"
3) File -> Delete

You will be asked if you want to continue this operation. Mark the check box and click Yes.

The reason why this extra step has been implemented is that this operation will delete everything
related to this activity/fault. This will be records of consumption, used  man hours etc. Use this
functionality with care!

To delete multiple activities/faults in one operation you can select these by clicking one record, hold
shift and the click the last record you want to delete. Then do the steps above.
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You can also hold CTRL and click the records you want to delete one at a time.

2.3.5.4 Search Activity/Fault

To perform a search, you need to know one of the following about the Activity or Fault you are
looking for: Task / Fault Type, Date, Machine Number, Machine Name or who signed the activity or
solved the fault.

To search for an activity/fault do one of the following:

1) File -> Search
2) Right click and click "Search"
3) CTRL + Q

Then you will get this form
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Enter the value for any of the following: Task / Fault Type, Date, Machine Number, Machine Name or
who signed the activity or solved the fault and click Search.

You will see the search results in the results grid. Click OK to return to the activities/faults tab. You
will be taken back to the activities/faults tab where the search result you selected is highlighted.

Note: You can only search for Activities/Faults that are present in the Location selected in the
Location Pane. If the Activity/Fault being searched for is not present in the selected Location, it will
not show up in the search results.
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2.3.6 Attachments

Attachments are files (or WWW links) that can be “attached” to a machine, task, spare part,
supplier, activity or fault.

This is very useful especially when you want to include additional information about a machine, task,
spare part, supplier, activity or fault that cannot fit into PM5. This could be a blueprint of a room,
detailed specifications of a machine or any kind of supplement.

You can attach any file or WWW link to a machine, task, spare part, supplier, activity or fault,
including spreadsheets, documents, database files, even sound recordings and graphic images.

In order to view an attached file, you need to have a copy of the software application that supports
reading of the file. For example, if you have a Microsoft® Word® document as an attachment, then
you must have Microsoft® Word® or an equivalent reader to be able to view the attachment.

In order to view an attached WWW link, you need to have an internet browser installed, such as
Microsoft® Internet Explorer®.

2.3.6.1 Add Attachment

1) To add an attachment, select the data that you want to add an attachment to.
2) Click on the Attachments Sub Tab and click Add Attachment.

3) Choose one of the following radio buttons: Upload File, Link File or WWW. If you choose either
Upload File or Link File, proceed to Upload or Link file. If you choose WWW, proceed to WWW.

Notes:
a. Choose Upload File if you want the attachment to be copied to your computer.
b. Choose Link File if you just want to create a “link” to the attachment but don’t want the
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attachment to be copied to your computer.
c. Choose WWW if you want to enter a World Wide Web (WWW) address.

Upload or Link file:

1) 4a) Click Browse For.
2) 5a) Select the file you want to attach and click Open.

3)  Click Add in the Attachment form.

WWW link:

1) Type the WWW address in the WWW box and click Add. 
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2) You will see the WWW address in the Attachments Sub Tab. This is the last step for attaching a
WWW address.

A special case applies to Task Attachment sub tab, wherein an extra field is added - Printable
checkbox. Printable checkbox allows you to determine if the attached file is capable of being printed
or not. 

The Task Attachment form

Attached files that are defined as printable can be also be printed directly along with the activity card
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where it is attached to.

Printing of Activity Card along with Task attachments

The following are the file formats that are printable in PM5:

· rich text files
· pdf files
· word document files
· excel files
· text files
· .dotx files
· .mht and .html files
· .xlsm files
· .docm files
· .xlsb files
· .xltx files
· .xltm files
· .csv files
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2.3.6.2 Delete Attachment

1) To delete an attachment, select the data where the attachment is attached.
2) Click Delete Attachment in the attachment sub tab.
3) A confirmation message will appear to you.

4) Click Yes from the options.
5) The Attachment gets deleted permanently and will no longer appear in the Attachments Sub Tab.

2.4 Menu Bar and Quick Access Toolbar
The Menu Bar displays a list of menus. The menus in PM5 consist of File, View, Tools and Help.

File contains the New, Create Copy, Edit, Delete and Search commands, which have been used
extensively throughout this manual. View contains commands that hide and show the Location
(found on the right pane) and Filter (found on the bottom). Tools contains commands for launching
Administration, Purchase, Consumption and Reports. Help has commands that will open the Client
Manual, Utilities Manual and the About window.

The commands in the menu may or may not be available depending on the privileges your User
Group has and on the selected tab. For example, if you are a part of a User Group that has the
necessary privileges and the active tab is the Machines Tab, all the commands in the File menu will
be available. On the other hand, if the active tab is the Activities / Faults Tab, the New command will
always appear disabled in the File menu.

The Quick Access Toolbar contains buttons that allow menu commands to be performed with just a
single click. The toolbar consists of New, Create Copy, Edit, Delete, Search, Reports, Location and
Filter.

This allows you to perform the selected commands faster. For example, you want to create a
Machine, instead of clicking on File > New to open the Machines form, all you have to do is click on
the New button and the Machines form will open.
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PM5 also allows you to change its color scheme, position of the quick access toolbar and the
visibility of the ribbon. You can do this by clicking on the PM5 icon and selecting Options…

Here, you can change the color scheme to black, blue or silver. You can also specify a filter, set the
Auto-Update, specify the default color, limit the number of rows to be shown in the main grid, set the
login timeout, position the quick access toolbar below the ribbon, minimize the ribbon and save tree
view state.

Filter - the Filter field in Options can be used if you want your data to be displayed according to the
criteria you set in a filter. 
Auto-Update (In minutes) - the number of minutes the Activities/Faults tab should update.
Show number of rows from the main grid - set the number of rows to be displayed in the main
grids i.e. Machines, Tasks, Spare Parts, Suppliers, Activities and Faults.
Login Timeout - Timeout (in minutes) determines how long before a user will be automatically
logged out after the predefined period of inactivity. (0 value means no timeout)
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Save tree view state check box - a checked mark means that your state of navigation tree/
location pane is saved when you close PM5, otherwise the tree is always collapsed when the client
launches.

This is what the top of PM5 looks like when the color scheme is set to blue, the toolbar is shown
below the ribbon and the ribbon is not minimized.

The drop down button beside the quick access toolbar allows you to change the position of the quick
access toolbar and to minimize the ribbon.

2.5 Measured Parameter
Aside from using the value of days field specified in the task form in calculating the next activity date
of a machine, you can use measured parameter to estimate its earliest next activity date. Measured
Parameter is discussed in details here. 

The measured parameter form in tools displays the list of measured parameter in PM5 with the
entered counter readings for each.
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Measured Parameters Form in tools

From here, you can select a measured parameter, then create or edit its counter readings.
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Measured Parameters Form in tools - showing how to edit a counter reading entry

To add a counter reading for a measured parameter, click the [New] button then you will get this
form.

Measured Parameter - New Values Form

Select the date and enter the counter reading for the measured parameter. You can click on the
[Calculate Average] button to see the average reading. Click Save.

Note: You cannot insert two counter readings on the same day.
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To edit a counter reading, click the [Edit] button and you will be presented with this form.

Measured Parameter - Previous Values Form

The form will display the date when it was last updated. Enter the new counter reading and select
the new date. You can click on the [Calculate Average] button to see the average reading. Click
Save.

Note: You can only edit the last record from the list of logs of measured parameter.

2.6 Notice Boards
Notice Board tool lets the user post notes and read notes posted by other user. To access Notice
Board, click on the Tools menu and select Notice Boards.

The Tools Menu - Showing the Notice Board

The Notice Board form will then be displayed to you. Notice Boards are created in the Administration
module of PM5. To learn how to create Notice Boards, click here.
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The Notice Board form

Note: Notice Boards are assigned to certain locations. Hence, only Notice Boards that are assigned
within your location access will be available to you.
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2.6.1 Posting, viewing and deleting Notes

To post a note, select the Notice Board you wishes to post a note to and click the 'Post a note'
button.

The Notice Board form - Showing how to Post a Note

After clicking 'Post a note', you will see a dialog where you can enter your notes. Click 'Post Note'
when you have finished filling out the form. The 'Title' is a required field.
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To view posted notes, select a Notice Board and the conversation title. The posted messages can
be seen on the right pane of the form.

The Notice Board form - Showing the message of the selected Notice Board conversation

To delete a posted note, select the note on the Notice Board where it is posted and click 'Delete
Note'.
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The Notice Board form - Showing how to delete a note

Note: You can not delete the messages posted by other user, you can only delete the messages
you have posted.

3 Administration Module
The following help files will give an in-depth introduction to the setting up of main administrative
settings of PM5. If you are a user looking to use the more basic features of PM5 you are probably
looking for the client application. You will find this by clicking here.

To access the Administration Module you need to log in to PM5 with a user with administrator
access. You will then see the main application screen. In the top of the screen is a menu where you
will find the item called "Tools". After clicking on it a small menu dialog will appear. On this you will
find the button leading to the administration module.

After clicking on it you will be presented to the administration module dialog, 
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As you will see there are three main administrative parts which can be configured from here; System
Tools, Configurations and System Variables. 

System Tools allows you to create new (and modify existing) Users, User Groups, Technical
Groups, Locations, Custom Field Groups, Input Masks and Language.

Configurations allows you to modify Registration Information.

System Variables allows you to create new (and modify existing) variables for Client, Purchasing
and OPC.

Read the sub-chapters to this file to learn more on each of the administrative settings that PM5
offers.

3.1 Users
A user is someone who has an account which has access or formerly had access to the PM5
system. It is only when we start setting up their specific rights that they will differ in terms of what
they can do and what they can see.

Let us first look at the specific information that a user consists of.
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Inf
or
ma
tio
n

Description

Us
er
ID

The User ID is what users will use to log in to both PM5. It is similar to what in many other systems is called Username. The User ID
must be unique for the system. Once we have created the user ID we will not be able to change it again, so please be careful to give it a
correct name initially.

Fir
st
Na
me

The First Names of the user.

La
st
Na
me

The Last Name of the user.

De
scr
ipti
on

The Description refers to the job title of the user in your business.

Em
ail

The Email of the user.

Mo
bile
Nu
mb
er

The Mobile Number of the user.

Pa
ss
wor
d

The Password is a set of characters that is used in combination with the User ID to identify whether or not the user should have access to
PM5. Included in the default installation is the User ID “pm5” and Password “pm5.” You can immediately use “pm5” to log in to PM5.
When creating a new user you will be asked to confirm the password to make sure that you typed correctly.

Def
aul
t
La
ng
ua
ge

The Default Language determines the language used in PM5. You can choose from Czech, Danish, Dutch, English, French, German,
Italian, Norwegian, Polish, Portuguese, Russian or Swedish as the Default Language.

Aut
o
up
dat
e
(in
mi
nut
es)

Auto update decides how often a user's activities/faults list will refresh itself when a user has the application open. When left empty it
means that the activities/faults list will not automatically reload.

Lo
gin
Pri
vile
ge

Login Privilege determines whether the user is allowed to log in to PM5 or not. If a User has a Login Privilege, the User ID and the
Password can be used for logging into PM5 Admin and PM5 Client. If you have an employee who no longer should have access to the
system (he may have left the company), you should remove his login privilege. The reason for not deleting him is, that the historical
information of what he did is still relevant to know for other users even though the employee may never actually be using the system
again. 
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Inf
or
ma
tio
n

Description

Al
wa
ys
Ac
ce
ss

Always Access is used to reserve slots for users. To get a good understanding of this feature, the Maximum Number of Users Allowed To
Login needs to be explained first.

The Maximum Number of Users Allowed To Login Allowed refers to the number of users that can log in to PM5 at any time. This number
is determined by the license purchased for PM5. If a five (5) user license was purchased, then the Maximum Number of Users Allowed To
Login is five (5) users. If a ten (10) user license was purchased, the Maximum Number of Users Allowed To Login is ten (10) users. The
Maximum Number of Users Allowed To Login is not the same as the Maximum Number of Users That Can Be Created. The Maximum
Number of Users That Can Be Created is
not limited by the license; you can create an unlimited number of users with any license.

Going back to Always Access, let us say you purchased a ten (10) user license for PM5 and your business has a total of twelve (12)
users. Now, eleven (11) of your users have Login Privileges and one (1) does not have a Login Privilege (possibly a Passive user or one
where Login Privilege = False). Out of the eleven (11) users that have Login Privileges, two (2) users have Always Access privileges and
nine (9) users have regular login privileges (they do not have Always Access privileges). Now, because you purchased a ten (10) user
license, out of eleven (11) users, the Maximum Number of Users Allowed To Login is ten (10) users.

Does this mean that you can only ten (10) out of eleven (11) users can log in all at the same time? Yes, however, it does not stop there.
Recall that you have two (2) users with Always Access privileges. This means that those two (2) users always have slots reserved for
them. So, out of the nine (9) users that have regular login privileges, only eight (8) users can login at any time because two (2) slots will
always be reserved for the two (2) users that have Always Access privileges.

Always Access is useful for Administrators because it makes sure that the user will always be able to login if there is something that
needs to be configured (i.e. resetting the Logged In status of a user to allow him to login again).

Pa
ssi
ve

A passive user is one who we no longer will want to assign e.g. tasks or in other ways be able to relate to in connection with work
assignments in the system. Passive users will never have login privileges, no matter if this setting is set to true on their user account.
Your business can take advantage of the passive users feature by assigning the passive status to users who are former employees, are
on leave or have moved on to a different, unrelated position in your business. This allows you to keep a record of all the employees who
have used PM5 in your business, without mixing them up with those users who have never had login privileges..

Lo
gg
ed
In

It is possible to force users out of the system by removing the check-mark of a user in the "Logged in" column in the user list. This may
be useful if a user is assumed to just have left his connection open and is taking up space without actively using the system. 
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3.1.1 Adding, editing and deleting users

The user list shows a number of columns to help identify the users that you have in your system.
Notice the columns "Logged in" and "Passive" that allow you to immediately change these settings
for individual users on the list. Clicking these columns will have an immediate effect on the database
and system. To understand the two settings please read the "Users" page.

The Administration Module User List - Showing how to add, delete and edit users

There are two ways in which we can perform actions on the list. One is via using the drop down
menu for item "Action" and the other is via right clicking anywhere on the list area. The Actions that
are offered are:

Action Description
New ... When creating a new user you will open the "New user" dialog. Here you must specify

some of the general information and settings of a user. To learn more on these settings
please read the "Users" page.

Delete If you accidentally created a user you do not need you can delete it. Deleted users are
both passive and have no login privileges. You should never delete users who used to
work for the company. Just make them passive in order to easily remember the
employees that historically have worked in the system,

Properties ..
.

Properties is used to edit existing users. It will offer almost the same settings as the
Add page, but update of password is done as an individual process rather than together
with the editing of the rest of the user information. To learn more on each of the user
properties on the General tab please read the "Users" page.

Besides the General tab you will also notice a "Member of" tab. This tab is used to
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Action Description
specify which groups a user should be member of. The two sub tabs offer membership
of "User Groups" and "Technical groups". Each tab has an "Add" and "Remove" button
to manage which groups of the specific type that the selected user is made member of.
Please go to the User Groups file or Technical Groups file to learn more on what these
types of groups are used for.

Show
Deleted
Users

Deleted users are never actually "Destroyed". They will still exist in the database but
just not be shown in the system. If you want to see the users that have been deleted
from the system or even restore them from their deleted state, you can use this action
to get access to the deleted users list dialog.

Refresh Refresh is used to reload the information of the user list. This may be necessary of
other people are working on the list at the same time.

Help When clicking help the user will always be directed to the help file relevant for the page
he is currently looking at.

3.2 User Groups
User Groups provide a way to assign Privileges, Locations as well as specify how the Interfaces
should look for a group of Users. By applying these settings on groups rather than on each individual
user we make sure that these settings are easier to maintain as well as it is quicker to apply to
users. Any user that is member of a User Group will inherit the settings of that User Group. If a user
is member of more than one User Group, then the combined access settings of the User Groups he
is member of, will make up the total access that he has as a User in the system.

We will in the following go through each of the main access settings that can be granted to a User
Group. Then on the related sub pages we will teach you how to actual apply and set up a new User
Group.

Main Information

The main settings of a User Group are quite simple. They just consist of a name, description and the
array of Users belonging to it. There is no restriction on Users being member of more than one User
Group at a time.

Privileges

Privileges are permissions to perform specific actions. For example, the ability to “Approve faults” is
a Privilege.

Here is a complete list of the Privileges available in PM5 Admin.

Privilege Description
Main
dataset

Main Dataset grants Users the privileges of creating new, copying, editing and deleting
Machines, Tasks, Spare Parts, Suppliers and Activities. It also allows Users to access
the Consumption Tool and to generate Reports.

User The “User” privilege gives Users the ability to create, edit and delete Users and User
Groups.

Group Group privilege allows Users to create new, edit and delete “Groups” in PM5 Admin. It
also allows Users to generate Reports.

Task Task Creation grants Users the right to create, delete and edit Tasks. It also allows
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Privilege Description
creation Users to access the Consumption Tool and to generate Reports. 
Task limited Task Limited grants Users the right to create “one-time” Tasks. “One-time” Tasks are

Tasks that do not have an interval and are performed only once.This privilege also
allows Users to generate Reports.

Activities
ack.
privilege

Activities ack. privilege gives Users the ability to mark activities as “done” in PM5
Client.

Activity
creation

Activity Creation gives Users the ability to create a new activity for tasks that are not
active. It also allows users to mark activities as “done.”

Remove
activity
news
marking

Remove Activity News Marking grants Users the right to change the way new Activities
appear in PM5 Client. By default, a new Activity appears “bold,” as in “Service oil 30
days.” When Users have this right, once they Edit a new Activity, its appearance will
change from “bold” to “not bold.”

Fault
privilege

Fault Privileges gives Users the rights to create new faults, delete faults and mark them
as “Solved” or “Not Solved.” It also gives the rights to create new Stops and delete
existing Stops.

Remove
fault news
marking

Remove Fault News Marking grants Users the right to change the way new Faults
appear in PM5 Client. By default, a new Fault appears “bold,” as in “Service oil 30
days.” When Users have this right, once they Edit a new Fault, its appearance will
change from “bold” to “not bold.”

Approval Approval gives Users the ability to approve faults. This means that Users who have this
privilege will be shown in the “Approved By” list.

Storage
privilege

Storage Privilege grants Users the right to create, copy, edit and delete Spare Parts
and Suppliers and it gives the right to allocate Spare Parts to Stores. It also allows
Users to access the Consumption Tool and to generate Reports.

Purchase/
Spare part

Purchase / Spare Part gives Users the ability to use the Purchase Module, the ability
to create, copy, edit and delete Spare Parts and Suppliers and the right to allocate
Spare Parts to Stores. It also allows Users to access the Consumption Tool and to
generate Reports.

Attachment Ability to create, delete and edit attachments.
Advance
Pocket PC

Advance Pocket PC grants Users access to the standard and advanced functions of
the bar code scanner.

Basic
Pocket PC

Basic Pocket PC grants Users access to the standard functions of the bar code
scanner.

Replace
Spare Part

Replace Spare Parts gives Users the ability to replace one spare part with another in

all associations between spare part that is to be replaced with its Machines, Tasks and

Activities/Faults.

Merge
Spare Parts

Merge Spare Parts grants Users the ability to merge or combine one spare part with

another in all associations between spare part that is to be merged with its Machines,

Tasks, Stores and Attachments.

Delete
Spare Parts

Delete Spare Parts gives Users the ability to delete spare part and all its associations.

Spare Parts that are deleted are set to 'Inactive' status.

Tabs
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Setting in tabs decide which main as well as sub tabs that users of a specific group will see.

The below list shows the main tabs and related sub tabs that a User Group can be granted access
to. If a user is not member of a group that has access to any of the listed tabs, he or she will also
not be given this tab upon login to the system.

Main Tab Sub Tabs
Machines Details, Tasks, Activities, Spare Parts, Faults, Stop, Attachments
Tasks Details, Activities, Spare Parts, Calibration, Attachments
Spare Parts Details, Machines, Consumptions, Stores, Suppliers, Attachments
Suppliers Details, Machines, Spare Parts
Activities /
Faults

Details, Spare / Parts, Calibration / Stop

Locations

This tab will list all the Locations that have been added to the system, so that it is possible to give
access to each single one of these. If a user is not member of a User Group that has access to a
location, then that location will not be shown to this user when he logs in.

There are four check states in marking the check box in Locations: Blank state, Checked state,
Checked gray or Boxed state and Unchecked and Name in Italic state.

Blank = No rights
Checked = All rights
Checked Gray or Boxed = Rights to the location and the machines selected and machines that you
create.
Unchecked and Name in Italic = No rights to the location but there is some rights further down the
tree for other sub-locations.

3.2.1 Suggested User Groups

By default the system has a number of default user groups set up. You are free to remove these as
you like, but they give some idea of the types of User Groups that typically are created in the
system.

Below is a table that summarizes the suggested User Groups. Beside each User Group Name are
the User Group Privileges that are to be checked. 

User Group Name User Group Privileges
Craftsmen Activities Ack. Privilege, Remove Activity News Marking, and Remove Fault

News Marking
Failure Fault Privileges, and Remove Fault News Marking
Personnel of Stocks Storage Privileges
Superior All privileges except Task Creation
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3.2.2 Adding, editing and deleting User Groups

The following page will introduce how to add, edit and delete User Groups. If you want to understand
the information and settings of User Groups please click here to read its description.

Let us initially look at where to access the three buttons for Add, Edit and Delete.

When in the Administrator dialog choose the User Groups menu item. After this you will see the
existing User Groups that exist in the system. If you want to delete or edit a User Group you must
highlight it in the list and then click either the 'Delete' or 'Properties...' (edit) buttons. These can be
accessed either via the drop down 'Action' menu item or via right clicking in the list area. If you are
adding a new User Group (button 'New...') you need not have any record highlighted.

The Administration Module User Group List - Showing how to add, delete and edit User Groups

After clicking 'New..' you will get a small dialog where only User Group name and Description can be
inserted. Only the name is actually required.

The Administration Module User Group Add Form

When you have finished setting the Name and Description of the User Group click the 'Add Group'
button.

Since you will be required to also set a number of other settings for a User Group you should after
creation highlight the new group and click the 'Properties...' button. This will open up the User Group
edit dialog. Below we will go through the 4 tabs where User Group information can be set up in.
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The Administration Module User Group Edit Form - The 'General Information' Tab

On the General tab of User Group it is possible to add those Users that should be member of the
specific group. By clicking the 'Add' button you will open a small dialog where you can choose
among existing users in the system and insert them. To remove a user form the group highlight it
and click the 'Remove' button.
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The Add User Form of Administration Module User Group Form

Starting v5.06, a Quick Filter is introduced in the Add User's form. If you have a long list of users in
your application, quick filter can help you find person/s easily on your list. Just enter the
corresponding values on the fields of the filter then click 'Search' to apply it.

The Privilege tab specifies the modules and features that Users of the User Group will have access
to. Just check the modules and features that are relevant for the group and the Users will have these
privileges granted on their next log in.
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The Administration Module User Group Edit Form - The 'Privileges' Tab

The Locations tab specifies which general Locations that Users of the User Group will have access
to.

The Administration Module User Group Form - The 'Locations' Tab

As you will see the locations are organized in hierarchies. Tick off any location that you want
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members of the User Group to have access to. For each location there may be multiple machine
types related. Once you choose a location you can then also specify which machine types
members of the User Group will have access to. Members will have access to all those locations
and machine types that one of the User Groups, in which they are member, has access.

The Administration Module User Group Form - The 'Tabs' Tab

On the last tab of User Group Properties, it is possible to specify which tabs that members of the
User Group will be able to see when logged in. The check and uncheck all button provide an easy
way to update all check boxes at once.

3.3 Technical Groups
If there are already User Groups, why is there a need for Technical Groups? Technical Groups allow
you to control which Users can be set as manpower resources for a Task in the PM5 Client. Setting
manpower resources means specifying which group is responsible for carrying out the task.

Technical Groups are not used for controlling access as is the case with User Groups.

In the PM5 Client, you can set manpower resources for a Task only if the Users are members of a
Technical Group that is assigned to the same Location as the Machine for which the Task is being
performed.

For example, let’s say you want to set manpower resources for a Task called Mandatory service,
which is being performed for a Machine called 1 BT truck Cargo 1,5 that is in the Location called
Outdoors. Let’s say you want to use as a manpower resource the User called JP who is a member
of the Technical Group Blacksmiths.
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To do this, you need to make sure that a group that JP is member of, e.g. Blacksmiths, is assigned
rights to the Location called Outdoors. Since the Machine called 1 BT truck Cargo 1,5 is in this
location, then any task made on this machine can be assigned to JP.

In the following sections, you will learn 'How to Create a Technical Group' and 'How to Add Members
to a Technical Group'. 

3.3.1 Adding, editing and deleting Technical Groups

The following page will introduce how to add, edit and delete Technical Groups. If you want to
understand the information and settings of Technical Groups,  please click here to read its
description.

Let us initially look at where to access the three buttons for Add, Edit and Delete.

When in the Administrator dialog choose the Technical Groups menu item. After this you will see
the existing Technical Groups that exist in the system. If you want to delete or edit a Technical
Group you must highlight it in the list and then click either the 'Delete' or 'Properties...' (edit) buttons.
These can be accessed either via the drop down 'Action' menu item or via right clicking in the list
area. If you are adding a new Technical Group (button 'New...') you need not have any record
highlighted.

The Administration Module Technical Group List - Showing how to add, delete and edit Technical Groups

After clicking 'New..' you will get a small dialog where only User Group name and Description can be
inserted. Only the name is actually required.

The Administration Module Technical Group Add Form

When you have finished setting the Name and Description of the User Group click the 'Add Group'
button.
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Since you will be required to also set the included users of a Technical Group you should after
creation highlight the new group and click the 'Properties...' button. This will open up the Technical
Group edit dialog. Below we will go through the 2 tabs where User Group information can be set up
in.

The Administration Module Technical Group Edit Form - The 'General Information' Tab

On the General tab of Technical Group it is possible to add those Users that should be member of
the specific group. By clicking the 'Add' button you will open a small dialog where you can choose
among existing users in the system and insert them. To remove a user form the group highlight it
and click the 'Remove' button.

The Locations tab specifies which general Locations that Technical Group will be used for.
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The Administration Module Technical Group Form - The 'Locations' Tab

3.4 Locations and Machine Groups
Locations and Machine Groups are used to group Machines and their associated Tasks, Spare
Parts, Suppliers, Activities and Faults. This will allow you to organize your Machines based on
where they are and what they do.

Why are there two kinds of groups?

There are two kinds of groups because it allows you to distinguish between physical locations and
product categories.

Locations are used refer to actual places and Machine Groups are used to group Machines by their
type.

For example, you could have a car dealership with Locations in “Denmark,” “USA” and “England” and
Machine Groups “Cars,” “SUVs” and “Multi-Purpose Vehicles."

You could also have a car factory that's located in "Copenhagen" and have multiple locations that
simply refer to places inside your factory. For example, inside the location "Copenhagen," you could
have the locations "Assembly Line," "Painting Area" and "Car Wash" and, depending on the engine
of the car, you could have the machine groups "Diesel," "Gasoline" and "Electric."

The following paragraphs tell you more about what can be done and what can not be done with



178 PCSYS Maintenance 5

© 2010 PCSYS A/S

Locations and Machine Groups.

Can I Create a Location within a Location?

You are allowed to create a Location within a Location. So, if you want to create a Location called
"Detailing" in "Painting Area," you can.

A Location within another Location

Can I Create a Machine Group within a Location?

You can create Machine Groups within a Location. This means that if you want to create a machine
group called "Washers" inside the Location "Car Wash," you can.

A Machine Group within a Location

Can I Create a Machine Group within a Machine Group?

It is legal in PM5 to create a Machine Group inside a Machine Group. So, if you want to create
Machine Groups for "Diesel" called "2.0 L" and "3.0 L," you can.
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Machine Groups with a Machine Group

Can I Create a Location within a Machine Group?

You cannot make a Location within a Machine Group. If you want to create a Location called
"Denmark" in the Machine Group "Diesel" you will not be allowed to.
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Error Message when trying to create a Location inside a Machine Group

Can I Create Locations with the Same Name?

You can create Locations with the same name as long as they are not on the same level. For
example, you can have three Locations called "Car Wash" if they are inside different locations. Keep
in mind that these three Locations with the same name are independent of each other, which means
that the Machines in the "Car Wash" in "Copenhagen" are different from the machines in the "Car
Wash" in "Odense."
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Three Locations with the same name in different levels

Can I Create Machine Groups with the Same Name?

You can also create Machine Groups with the same name but in different levels. Keep in mind that
these three Machine Groups are independent of each other, which means that Machines in the
"Diesel" Machine Group in "Copenhagen" are different from the machines in the "Diesel" in
"Odense."

Three Machine Groups with the same name in different levels

How you choose to make use of Locations and Machine groups depends on you and the type of
your business. The important thing to remember is that they are there to help you get your Machines
organized.

3.4.1 Adding, editing and deleting Locations

The following page will introduce how to add, edit and delete Locations. If you want to understand the
information and settings of Locations, please click here to read its description.

First, let us look at where to access the buttons for Add, Edit and Delete.

When in the Administrator dialog choose the Locations menu item. After this you will see the
existing Locations and Machine Groups that exist in the system. If you want to delete or edit a
Location or Machine Group you must highlight it in the list and then click either the 'Delete' or
'Properties...' (edit) buttons. These can be accessed either via the drop down 'Action' menu item or
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via right clicking in the list area. If you are adding a new Location or Machine Group (button 'New...')
you do not need to have any record highlighted.

The Administration Module Locations Tree - Showing how to add, delete and edit Locations

After clicking 'New..' you will see a dialog where Location and Type and Property Group can be
selected. Location and Type are required. For more information on the different types (Location and
Machine Group), please click here. If you want to know more about Property Groups, please click
here.

The Administration Module Locations Add Form

When you have finished entering a name for your Location or Machine Group, click the "Ok" button.
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A notification is displayed whenever you create a Location at Level 1. It is a reminder that the
Location created is not yet associated to any user group, hence will not be accessible in the client
until you assigned it to a user group . Press the 'Ok'  button to continue.

Notification when User creates new Location at Level 1

Can I change the Type of a Location or Machine Group after creating it? Yes, but only if it does not
have any child Locations or Machine Groups. If it has any Locations or Machine Groups under it,
you will not be allowed to change its type.

The Administration Module Locations Properties Form (Type is Locked)
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3.4.2 Assigning Stores to Locations and Machine Groups

The following page will introduce how to assign stores to locations. It allows you to control which
Stores will be available in certain Locations. If you want to learn more about Stores, click  here.

In the list of administrative module, select Location and you will be presented with your list of
locations displayed in a tree view.

Select the location you want to assign a store, in the Stores column click on the arrow down
symbol. A drop down checklist will show up, displaying all the possible Stores that can be
assigned. 

Simply place a check on the Store that you wish to associate to the current Location.  Associations
that already exist will show up as checked.  Un-checking them will remove their association.

Click OK to save the association. The list of stores assigned to a location can be seen in the Stores
column of Location. If the selected location has child locations, it will automatically inherit the stores
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of its parent location.

Inherited stores cannot be removed. However, you can still associate stores to a child location.

Note 1: Stores that will be displayed in the client module depends on what stores are available in
locations assigned to the user group where a user belongs. To learn how to assign locations to a
user group, click here.
Note 2: .  For clients that are upgrading to v5.05, all Stores will be, by default, accessible on all
Level 1 (top-level) Locations.  This way, you can refine the Store-Location accessibility by refining it
in the Admin module.

3.5 Custom Field Groups
What if you wanted to to create new fields in PM5? Let’s say you have a car and you want to define
its color, fuel level and break-in date. How would you do that? You can create new fields in PM5 with
Custom Field Groups. You can do this not just for your Machines but also for your Spare Parts,
Suppliers, Tasks, Locations and Machine Groups.

Below is an example:
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The Administration Module Custom Field Group Properties Form

After creating your Custom Field Group, you can immediately use it in your Machine.

3.5.1 Adding, editing and deleting Custom Field Groups

The following page will introduce how to add, edit and delete Custom Field Groups. If you want to
understand the information and settings of Custom Field Groups, please click here to read its
description.

Let us first look at where to access the buttons for Add, Edit and Delete.

The Administration Module Custom Field Group List - Showing how to add, delete and edit Custom Field
Groups
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After clicking 'New..' you will see a dialog where Group Name and Type and Properties (Fields and
Types) can be defined. The Group Name, Type and at least one Property is required.

The Administration Module Custom Field Group Add Form

As you might have already read in the description of Custom Field Groups, you can create new
fields for Machines, Tasks, Spare Parts, Suppliers, Locations and Machine Groups.

In Properties, you can choose between three types: Date, Number and Text.

If you choose Date, you'll only be allowed to enter valid dates such as "03 August 2009,"
"08/03/2009" and "August 3, 2009."

For a Number type, you can only enter numbers such as "0," "5491" and "9753124680."

Text allows you to enter letters, numbers and special symbols. For example, entering:
"john.3.16@gmail.com" is a valid text input. 

Below is an example of a Custom Field Group being used in the Client Application:
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Custom Machine Properties in Client Application

Can you delete a Custom Field Group if it is currently being used? No. PM5 will not allow you to
delete Custom Field Groups that are currently being used in the Client Application. This way, it is
much harder to accidentally wipe out a lot of custom data.

3.6 Input Masks
Input Masks allow you to automatically create input for fields. For example, if you create an input
mask for Machine Number called "B1-&&&&&," all your Machine Numbers will automatically have
"B1-" as their first three characters. After that, you can enter any character for the last five. This
means you could have "B1-99@ZZ" as a Machine Number.

An Input Mask called "B1-&&&&&"

In the above example, Sample Data allows you to test the Input Mask you've created.

What characters are used to create an Input Mask? The table below shows you those characters
and what they do:

Character(s) Effect

1,2,3,4,5,6,7 and 8 Always forces 1,2,3,4,5,6,7 or 8 to appear

Uppercase  and  lowercase  letter
B,  lowercase  c  and  uppercase
and lowercase letters D to Z

Always forces uppercase  and  lowercase  letter  B,  lowercase  c
or uppercase and lowercase letters D to Z to appear

!, @, $, %, ^, *, (, ), {, }, [,  ],  :,  ;,
 “, ‘, _, - and +

Always forces the respective characters to appear
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#, 0 or 9 Allows you to enter only numbers

? Allows you to enter only letters

A or a Allows you to enter only letters and numbers

& or C Allows you to enter any character

\ Escape Character – Forces “wildcards” to be displayed

What fields can you create Input Masks for? You can create Input Masks for Machine Number,
Machine Name, Spare Part Number, Spare Part Name, Account Number and Task Name.

For what other purpose can you use Input Masks? In addition to automated input, it also allows you
to restrict input. Let's say you created an input mask called "###???." What happens then? With
that input mask, you restrict the user to entering only numbers for the first three characters, only
letters for the last three and a maximum of only 6 characters. This means that only input such as
"563YJB" will be allowed. If you try to enter characters other than those in the Input Mask, you will
not be allowed to.

An Input Mask called "###???"

If you created an input mask called "(21JEZ@$)-??00&&," you would get this result:

An Input Mask called "(21JEZ@$)-??00&&"

What are wildcards? Wildcards are the characters #, 0, 9, ?, A, a, C and &. They do not appear in
the field if they are part of the input mask. To force these wildcards to be included, you need to use
the Escape Character "\." For example, if you want 90A to appear in an Input Mask, you would need
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to create an Input Mask called "\9\0\A." The example below shows you what happens when
wildcards are escaped:

An Input Mask called "\9\0\A-90A"

3.6.1 Adding, editing and deleting Input Masks

The following page will introduce how to add, edit and delete Input Masks. If you want to understand
the information and settings of Input Masks, please click  here to read its description.

First, let us look at where to access the buttons for Add, Edit and Delete.

The Administration Module Input Masks List - Showing how to add, delete and edit Input Masks

After clicking 'New..' you will see a dialog where Type and Input Mask can be defined. The Type and
Input Mask are required.



191Administration Module

© 2010 PCSYS A/S

The Administration Module Input Masks Add Form

When you have finished choosing the Type and entering the Input Mask, you can test the Input
Mask in Sample Data.

The Administration Module Input Masks Add Form - Showing how to enter Sample Data

3.7 Notice Boards
Notice boards in the Administration module contains the list of Notice boards. It also allows you to
manage all the Notice boards that resides in the application.

The Administration Module Notice Board - Showing the List of Notice Boards available in PM5
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3.7.1 Adding, editing and deleting Notice Boards

The following page will introduce how to add, edit and delete Notice Boards.

Let us look first where we can access the buttons for Add, Edit and Delete.

The Administration Module Notice Board List - Showing how to add, delete and edit Notice Boards

After clicking 'New..' you will see a dialog where Notice Board Name, Location assignment and
Description can be defined.

The Administration Module Notice Board Add Form

1) Provide a Name for your Notice Board.
2) Select the Location assignment of the Notice Board by clicking on the down arrow and clicking

the 'Accept' button to assign it.
3) Provide a descriptive text for the Notice Board.
4) Click Save.

3.8 Languages
PM5 will offer 12 different default languages. These default languages cannot be deleted or edited but
it is possible to create a new language by highlighting an existing language and clicking the 'Copy'
button (Action -> Copy). The language that was copied from will be the 'Base language' of the new
language, meaning that it will be the language used as default when text resources are missing for
the new language. Below is shown an example of how a new language 'English - UK' will appear in
the dialog:
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The Language Dialog

For information on how to create translations for a non-default language, please click here.

It is possible to delete non-default languages as well as update their names using the 'Delete' and
'Properties' buttons found in the Action menu.

The Language Dialog Action Menu
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3.9 Options
Options is where you can enter your license information, set your company logo and change other
configuration settings.

The Options Dialog

When you get your licensing information, enter it in Registration and click the "Ok" button to check
its authenticity. If you entered a valid name and code, PM5's features will be upgraded to the level in
your license.
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The Options Dialog - Registration

To set your Company Logo, which will be shown whenever you print Reports, click the "Browse For
File..." button and look for your desired image. PM5 supports the JPEG, ICO, BMP, TIFF and GIF
image formats. If you wish to remove the current logo, click "Clear."

The Options Dialog - Logo

The next paragraphs discuss the other configuration settings in PM5.

The Attachment Folder is the folder where your attachments in the Client Application are stored.
Attachments simply refer to files, such as documents, images, etc. You can attach files to a
Machine, Task or Spare Part by going to their Attachments Tab. You should set your attachment
folder to a shared folder in your drive or to a location on your network server so that other users will
be able to download your attachments. Setting it to a local folder that is not shared will make your
attachments impossible to get hold of for the users.

Whenever you log in to PM5, your status will be set to "logged in" and no other user can use your
account until you log out. Unfortunately, you may not always be able to log out because your
computer could crash, you experience a power failure or face a similar problem that causes PM5 to
terminate before you are able to log out. The problem is, unless your status is set to "logged out,"
you will not be able to log in. How is this problem solved?

Timeout (In minutes) was designed to specifically address this problem. It defines the amount of
time PM5 will wait before setting the status of a user to "logged out." This way, if PM5 terminates
prematurely, you will be able to log in after a certain period of time. For example, due to a power
interruption, PM5 terminates before you are able to log out. If you set the Timeout to 5, you just wait
5 minutes then you can log in again. This beats never being able to use your account again.
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When you create a user, you have the option to set the value of its Auto-Update. If you've already
read the section on Users, you'll know that Auto-Update controls how often the Activities & Faults
list is reloaded. Here in Options, the Minimum Auto-Update (In Minutes) sets the minimum value that
the user is allowed to set for his Auto-Update interval. This means that if you enter 5 as the
Minimum Auto-Update, the lowest value that a user is allowed to enter in his Auto-Update is 5. If he
enters a value lower than 5, Auto-Update will be disabled for his account.

Root Location Text allows you to change the text of the root node of the Location tree in the
Administration and Client modules.

The Location Tree - Showing a different text on the root node

What you enter in the Report Header box will appear on the header of all reports.

If you mark the Print Label Directly to Printer check box, it means you enable the printing of labels
directly to the printer. No visual confirmation and no preview document will be seen on the screen
once you chooses to print barcode through the Quick Access menu of Spare Part grid and 'Print
Barcode' button of the Spare Part form.

Below is an example of a customization of the other configuration settings:

The Options Dialog - Other Configuration Settings
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3.10 Translations
The translation module makes it possible to create translations for new languages (i.e. not default
languages). To see how to create new languages please click here. To start translating simply
choose a new language in the Language drop down. If you choose one of the default languages, the
middle column called "Translation" will not appear and you will only be able to review the shown
language. 

The Language Translation Dialog

To start translating simply just choose the field in the Translation column that you wish should differ
from the "Base Translation" value and insert it. Initially you will only be shown 10 of the text
resources of the system, but you can use the pager in the bottom of the screen to see the rest. You
can also choose to show a different number of text resources on each page by using the 'Rows per
page' drop down. Choose the 'value' all to get the entire list of texts that can be translated.

You do not need to translate texts that are the same as the base language shown. If a value does
not exist for the new language, then it will inherit the value from the base language.

When you are ready to save either use the 'Save' button on the panel below the text resource list or
use the Save button in the Action menu. You will in the Action menu also find a cancel button you
can use if you regret the translations you have been made in the session.
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3.11 Support

Feature under development. It is currently possible to set the values of email address and telephone
number but the feature that makes use of this information has not been implemented yet.

In the future, this will be used to set the email address and telephone number that will appear
whenever PM5 throws an exception. This way, the users will have a way of asking for support
whenever PM5 encounters a bug.

3.12 System Variables
If you have been using PM5, you will notice that there are some fields in the client that have a "fixed"
list of values that you can not seem to change.

For example, if you open a Machine and try to select a Type, you can only select from a list; you
can not enter new types. 
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The Client Application Machine Properties Form - Showing a "fixed" list of Machine Types

If you needed to create a new Machine Type or a new value for another "fixed" field, how would you
do it? You can update Machine Types and other "fixed" fields from within System Variables. Here is
a list of the fields in the Client Application that you can update in the Administration Module:

1. Machines
· Types: System Variables -> Client -> Machines -> Types
· Account Numbers: System Variables -> Client -> Machines -> Account Numbers
· Measured Parameters: System Variables -> Client -> Machines -> Measured Parameters

· Measured Unit Types: System Variables -> Client -> Machines -> Measured Parameters ->
Unit Types 

2. Tasks
· Types: System Variables -> Client -> Tasks -> Types
· Calibration Groups: System Variables -> Client -> Tasks -> Calibration Groups

3. Spare Parts
· Groups: System Variables -> Client -> Spare Parts -> Groups
· Manufacturers: System Variables -> Client -> Spare Parts -> Manufacturers
· Stores: System Variables -> Client -> Spare Parts -> Stores
· Consumption Types: System Variables -> Client -> Spare Parts -> Consumption Types

4. Suppliers
· Phone Types: System Variables -> Client -> Suppliers -> Phone Types
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5. Faults
· Cause Types: System Variables -> Client -> Faults -> Cause Types
· Down-time Types: System Variables -> Client -> Faults -> Down-time Types
· Types: System Variables -> Client -> Faults -> Types
· Stop Groups: System Variables -> Client -> Faults -> Stop Groups

Aside from the fields in the Client Application, you can also update fields in the Purchasing Module,
OPC Module and Postal Information:

1. Purchasing
· Accounts: System Variables -> Purchasing -> Accounts
· Contact Information: System Variables -> Purchasing -> Contact Information
· Settings: System Variables -> Purchasing -> Settings
· Taxes: System Variables -> Purchasing -> Taxes

2. OPC
· Faults: System Variables -> OPC -> Faults
· Measured Parameters: System Variables -> OPC -> Measured Parameters

3. Postal Information
· Countries: System Variables -> Postal Information -> Countries
· Zip Codes: System Variables -> Postal Information -> Zip Codes

You can get more detailed information on how to add, edit and delete values in these fields and their
relationship to their parent modules in the following sections.

3.12.1 Client

Client contains a list of modules in the Client Application. If you want to go directly to a sub item,
you can double click on its name to "jump" directly to that item. For example, if you double click on
Machines, you will be taken to the Machine node.

The Administration Module System Variables -> Client List - Showing how to jump to child nodes

To read more about the modules in Client, click on the links below:
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· Machines
· Tasks
· Spare Parts
· Suppliers
· Faults

3.12.1.1 Machines

Machines contains a list of the "fixed" fields found in a Machine in the Client Application.  If you want
to go directly to a sub item, you can double click on its name to "jump" directly to that item. For
example, if you double click on Types, you will be taken to the list of Types.

The Administration Module System Variables -> Client -> Machines List - Showing how to jump to child
items

To read more about a 'fixed' field in a Machine, click on one of the links below:
· Types
· Account Numbers
· Measured Parameters

· Measured Unit Types

3.12.1.1.1  Types

Machine Types allow you to group machines by their type. Let us say you have three machines: A
Pick-up Truck, an SUV and a Mini-Van and you would like to group them together. One way to do
this is to assign the Machine Type "Light Truck" to all three. This way, when you sort your Machines
by type, these three will be grouped together.
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The Client Application Machine Tab - Showing Machines grouped together by Type

The following paragraphs will show how to add, edit and delete Machine Types and will describe their
relationship to the Client Application.

Let us look at where to access the buttons for Add, Edit and Delete.

The Administration Module Machine Types List - Showing how to add, delete and edit Machine Types

After clicking 'New..' you will see a dialog where Type and Description can be defined. Only the Type
is required.
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The Administration Module Machine Types Add Form

All the Machine Types that appear in the Administration Module can be selected in the Client
Application.

The Administration Module Machine Types List and The Client Application Machine Add Form - Showing
the Machine Types available
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3.12.1.1.2  Account Numbers

Account Numbers allow you to group Machines together. You can assign Account Numbers to
Machines in the Machine Add\Edit Form in the Client Application.

The Client Application Machine Add\Edit Form - Showing how to assign an Account Number to a Machine

An Account Number helps you identify which Account a Machine or a group of Machines belong to
when producing a Report about the Consumption of their Spare Parts.
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The Consumption Reports Form - Showing how to generate a Report using Account Numbers

The following paragraphs will show how to add, edit and delete Account Numbers and will describe
their relationship to the Client Application.

Let us look at where to access the buttons for Add, Edit and Delete.

The Administration Module Account Numbers List - Showing how to add, delete and edit Account
Numbers
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After clicking 'New..' you will see a dialog where Account No and Description can be defined. Only
the Account No is required.

The Administration Module Machine Account Number Add Form

All the Account Numbers that appear in the Administration Module can be selected in the Client
Application.

The Administration Module Machine Account Numbers List and The Client Application Machine Add Form
- Showing the Account Numbers available

3.12.1.1.3  Measured Parameters

When you buy a new car you will often be asked to have it brought in for a service check every
certain number of kilometers or within a certain amount of time, e.g. every 5000 kilometers or every 3
months. It is possible to arrange the same system with the Measured Parameters feature of PM5.

In PM5 you call the process of doing Service Checks on your car a 'Task.' Whenever the service
check is actually performed on the car it is called an 'Activity.' Click on Tasks or Activities to learn
more on this.

A task can thus be set up to have an activity carried out every certain number of days. If you have
set up a task that needs to be carried out every 30 days you set 'Interval days' of the task to 30.
Whenever an activity of that task is done it will automatically propose an activity 30 days later than
the scheduled date.

If the machine that the task belongs also has a measured parameter set, there is a chance that the
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next proposed date would be earlier than 30 days. Let us look into how this can happen.

Let's say that the machine in question is a car, which needs to be checked every 30 days or every
1000 kilometers (set as the measured parameter). If the 1000 kilometers are estimated to be
reached earlier than 30 days, the next activity will be scheduled to be carried out earlier. When there
are values for both Days and Measured Unit, an activity is scheduled based on whichever comes first
- the number of days or the accumulated value of a measured parameter.

Measured parameters are always based on a unit of measurement (e.g. kilometers, grams, liters)
which can be set up using Unit Types.

After this you set up the measured parameter, which you can read more about by clicking here.

To read more on adding a measured parameter to a machine, please click here.

To see an example of how a measured parameter actually influences the next activity date please
click here.

3.12.1.1.3.1  Unit Types

Unit Types is where you can create Units for Measured Parameters. For example, you could create
'Kilometer' as a unit, which could be used to represent mileage. Or you could create 'Liter,' which
could be used to show fuel levels.

The following paragraphs will show how to add, edit and delete Unit Types and will describe their
relationship to Measured Parameters.

Let us look at where to access the buttons for Add, Edit and Delete.

The Administration Module Unit Types List - Showing how to add, delete and edit Unit Types

After clicking 'New..' you will see a dialog where Unit Name and Unit can be defined. Unit Name and
Unit are both required.
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The Administration Module Unit Types Add Form

The Unit Types that appear here can be selected in the Unit dropdown box when adding\editing
Measured Parameters.

The Administration Module Measured Parameters Add Form - Showing the Unit Types available

3.12.1.1.3.2  Setting up Measured Parameters

The following page will introduce how to add, edit and delete Measured Parameters. If you would like
to get an overview of Measured Parameters please click here to read its description.

Let us look at where to access the buttons for Add, Edit and Delete.

The Administration Module Measured Parameters List - Showing how to add, delete and edit Measured
Parameters
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After clicking 'New..' you will see a dialog where Measured Parameter, Unit, Max Counter Reading
and Expected Average Per Day can be defined. All fields are required.

The Administration Module Measured Parameters Add Form

The text in Measured Parameter is what will be used to identify the measured parameter in the
Client Application, the Unit is the unit of measure that it will use (you can define this in Unit Types),
Max Counter Reading is the maximum value that the measured parameter is allowed to accumulate
and Expected Average Per Day is the value that the machine is expected to accumulate every day.

3.12.1.1.3.3  Example of Measured Parameter

The following page will show you how to use Measured Parameters. If you would like to get an
overview of Measured Parameters please click here to read its description.

Let's say that you have a truck that has a timing belt that needs to be replaced every 10,000
kilometers. How can you schedule that Activity in such a way that it is performed whenever your
truck accumulates 10,000 kilometers? You can do that by using Measured Parameters.

The following paragraphs will guide you step by step - from the creation of a Measured Parameter in
the Administration Module to how they are used in the Client Application.

First, let's create a Unit Type. This will be the unit of measure of your Measured Parameter.

In the Administration Module, go to System Variables -> Client -> Machines -> Measured
Parameters and click Action -> New.
Type "Kilometer" in Unit Name and "Km" in Unit and click Ok.
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The Administration Module Unit Types List - Showing how to add a Unit Type

In the Administration Module, go to System Variables -> Client -> Machines -> Measured
Parameters and click Action -> New. Type "Mileage" in Measured Parameter, select "Kilometer -
Km" in Unit, type "999999" in Max Counter Reading and "50" in Expected Average Per Day and
click Ok.

The Administration Module Measured Parameters List - Showing how to add a Measured Parameter

Close the Administration Module. Click on the Machines Tab in the Client Application. Type "2" in
the "Go to page" box and press [Enter]. You should see "3 Montini Truck" on top of the list. Now,
double click on "3 Montini Truck."
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The Client Application Machines Tab - Showing how to access a Machine

Check the "Use Measured Value" box, select "Mileage" in Measured Parameter and click Save.
Then click Ok to close the window that says the data has been successfully updated.
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The Client Application Machine Edit Form - Showing how to assign a Measured Parameter to a Machine

Click on the Tasks Sub Tab and click New Task.

The Client Application Machines Tab - Tasks Sub Tab - Showing how to create a new Task

Type "Change Timing Belt" in Task Name, select "Planned servicecheck" in Type of Task, type "90"
in Days and "10000" in Measured Unit and click Save. You will be prompted for the Date of First
Activity. Accept the default value (the date today) and click Ok.
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The Client Application Task Add Form - Showing how to add a new task with Measured Units

Let's say you performed the first maintenance activity on the first scheduled date. Go to the
Activities Sub Tab and double click on "Change Timing Belt."

The Client Application Machines Tab - Activities Sub Tab - Showing how to go to an Activity

You will be taken to the Activites Tab. Double click "Change Timing Belt".
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The Client Application Activities/Faults Tab - Showing how open an Activity

Check the "Done" box, select the date today in Activity Done and click Save. You will be prompted
to enter a counter reading in Measured Parameter. We will go back to this later. For now, just click
Close.

The Client Application Activities Edit Form - Showing how to mark an Activity as done
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Next, you will be prompted for the date of the next Activity. Because you have not entered any
counter readings, the number of days (90) will be used as the Interval. So, the date you see right
now is exactly 90 days after the date of the first activity. For now, accept this date and click Ok.

The Client Application - Schedule Activity Form

Click on the Machines Tab, make sure "3 Montini Truck" is selected and click on the Activities Sub
Tab and take a look at the next activity date. This date was calculated based on the number of days
entered in the Interval (90). It will change once you enter counter readings in measured value, which
you will do in the next step.

The Client Application Machines Tab - Activities Sub Tab - Showing the date of the next activity

Now, click on the Details Sub Tab and click on the  button beside the Measured Parameter
box. This will open the Measured Parameter form. Click New to enter a counter reading.
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The Client Application Measured Parameter Add Form

Since this is the first counter reading, type "0" in Counter Reading and click Save.
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The Client Application Measured Parameter Edit Form - Entering the first counter reading

Let's enter another reading. Once again, click New. Type "5000" in counter reading and select a date
about a month from the current date and click Save.
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The Client Application Measured Parameter Edit Form - Entering another counter reading

Because two counter readings greater than 0 are required in order for Measured Parameters to
recalculate the date of the next activity, let us enter a third counter reading. Click New and type
"9000" in counter reading, select a date about two months from the current date and click Save.

Close the Measured Parameter window and go to the Activities Sub Tab. Look at the date of the
next activity. You will see that it has been adjusted to an earlier date. Why? Because the counter
reading is approaching "10,000" - the value that you set in the Machine's Measured Unit Interval - the
date was adjusted accordingly.
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3.12.1.2 Tasks

Tasks contains a list of the "fixed" fields found in a Task in the Client Application.  If you want to go
directly to a sub item, you can double click on its name to "jump" directly to that item. For example,
if you double click on Calibration Groups, you will be taken to the list of Calibration Groups.

The Administration Module System Variables -> Client -> Tasks List - Showing how to jump to child items

To read more about a 'fixed' field in a Task, click on one of the links below:
· Types
· Calibration Groups

3.12.1.2.1  Types

Task Types provide a way to categorize Tasks. You can also create reports on Tasks using Task
Types.

To learn how to assign Task Types to a Task, please click here.

To see how to produce a Report using Task Types, click here.

Now, let's take a look at how to add, edit and delete Task Types.
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Below, you can see the menu items adding, editing (Properties...) and deleting.

The Administration Module Task Types List - Showing how to add, delete and edit Task Types

When you click 'New..,' you will see a dialog where Task Type and Description can be defined. Only
the Task Type is required.

The Administration Module Task Type Add Form

All the Task Types that appear in the Administration Module can be selected in the Client
Application.
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The Administration Module Task Types List and The Client Application Task Add Form - Showing the
Tasks available

3.12.1.2.2  Calibration Groups

Calibration Groups provide a way to enter additional data for Tasks. They are similar to Custom Field
Groups in the way that they both allow you to add new fields. However, in Custom Field Groups, if
you make any changes to the values you entered, you are unable to look back on its past values.
With Calibration Groups, you can choose to enter data every time a Task is performed and you can
keep track of the changes you've made by looking at its Calibration History.

To learn how to use Calibration Groups in the Client Application, please click here.

Now let's take a look at how to add, edit and delete Calibration Groups.

Below, you will see the menu items adding, editing (Properties...) and deleting.

The Administration Module Calibration Groups List - Showing how to add, delete and edit Calibration
Groups
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When you click 'New..,' you will see a dialog where Group Name and Fields can be defined. Only the
Group Name is required.

The Administration Module Calibration Group Add Form

Field is where you enter your desired name for your custom field.

Type controls what data can be entered in the field. The types available are Date, Number and Text.
The values you will be able to enter in the field will depend on the type of the field. A field that has a
'Date' type only accepts Dates, a 'Number' type will only accept numbers and a 'Text' type will allow
you to enter virtually any type of text.

The last field, Reading, controls whether a value can recorded in the field every time an Task is
performed. If the Reading box is checked, a value can be entered every time. If it is not checked, the
value of the field can only be entered once. To see how this works in the Client Application, please
click here.
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The Administration Module Calibration Group Edit Form

All the Task Types that appear in the Administration Module can be selected in the Client
Application.

The Administration Module Calibration Groups List and The Client Application Task Tab Calibration Sub
Tab - Showing the Calibration Groups available

3.12.1.3 Spare Parts

Spare Parts contains a list of the "fixed" fields found in a Spare Part in the Client Application.  If you
want to go directly to a sub item, you can double click on its name to "jump" directly to that item.
For example, if you double click on Stores, you will be taken to the list of Stores.
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The Administration Module System Variables -> Client -> Spare Parts List - Showing how to jump to child
items

To read more about a 'fixed' field in a Spare Part, click on one of the links below:
· Groups
· Manufacturers
· Stores
· Consumption Types
· Inactive Spare Parts

3.12.1.3.1  Groups

Spare Part Groups help you to categorize your Spare Parts.

To learn how to assign Groups to a Spare Part, please click here.

Now let's take a look at how to add, edit and delete Spare Part Groups.

Below, you will see the menu items for adding, editing (Properties...) and deleting.

The Administration Module Spare Part Groups List - Showing how to add, delete and edit Spare Part
Groups
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When you click 'New..,' you will see a dialog where Group Name and Description can be defined.
Only the Group Name is required.

The Administration Module Spare Part Group Add Form

All the Spare Part Groups that appear in the Administration Module can be selected in the Client
Application.

The Administration Module Spare Part Groups List and The Client Application Spare Part Add Form -
Showing the Spare Part Groups available

3.12.1.3.2  Manufacturers

Manufacturers help you identify the manufacturers of a Spare Part.

To learn how to assign Manufacturers to a Spare Part, please click here.

To see how to produce a Report using Manufacturers, click here.

Now let's take a look at how to add, edit and delete Manufacturers.

Below, you will see the menu items for adding, editing (Properties...) and deleting.
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The Administration Module Manufacturers List - Showing how to add, delete and edit Manufacturers

When you click 'New..,' you will see a dialog where the Manufacturer's Name, Contact Person and
Number can be defined. Only the Manufacturer's Name is required.

The Administration Module Manufacturer Add Form

All the Manufacturers that appear in the Administration Module can be selected in the Client
Application.

The Administration Module Spare Part Manufacturers List and The Client Application Spare Part Add
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Form - Showing the Manufacturers available

3.12.1.3.3  Stores

Stores represent storage areas such as rooms, shelves, floor levels, etc.

To learn how to use Stores in the Client Application, please click here.

To see how to produce a Report using Stores, click here.

Now let's take a look at how to add, edit and delete Stores.

Below, you will see the menu items for adding, editing (Properties...) and deleting.

The Administration Module Stores List - Showing how to add, delete and edit Stores

When you click 'New..,' you will see a dialog where the Store's Name, Area Label, Section Label and
Position can be defined. Only the Store's Name and Area Label are required.
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The Administration Module Store Add Form

The Area Label, Section Label and Position Label help you to define the where your Store is located.
Let's say you have a store called "My Closet" located in room 201A of the IT Department on the
second floor. To define that store in PM5, you would use "My Closet" as its Name, "Second Floor"
as its Area Label, "IT Department" as its Section Label and "201A" as its Position Label. You can a
add more describing text for the store.

The Administration Module Store Edit Form

When you put a check on the Associate to all Level 1 Locations checkbox, it means that you are
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assigning the stores to all level 1 or parent locations.

Automatic association of store to all level 1 locations

All the Stores that appear in the Administration Module can be selected in the Client Application.

The Administration Module Spare Part Stores List and The Client Application Spare Part In Store Add
Form - Showing the Stores available

3.12.1.3.4  Consumption Types

Spare Parts are used to replace parts in a Machine that have stopped working. Consumption Types
identify "why" the Spare Part is being replaced.

For example, if the Consumption Type is "Wear," you will know that the reason the part was
replaced is because the part has been worn out after normal use. If the Consumption Type is
"Breakdown," you would know that the part is being replaced because it broke down earlier than it
normally should.

To learn how to use Consumption Types in the Client Application, please click here.

Now let's take a look at how to add, edit and delete Consumption Types.

Below, you will see the menu items for adding, editing (Properties...) and deleting.
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The Administration Module Consumption Types List - Showing how to add, delete and edit Consumption
Types

When you click 'New..,' you will see a dialog where the Consumption Type can be defined. Here you
can also set the Consumption Type as default, which means it will always be the value used for
Consumption Type unless another one is selected. You are required to enter a Name.

The Administration Module Consumption Type Add Form

All the Consumption Types that appear in the Administration Module can be selected in the Client
Application.
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The Administration Module Consumption Types List and The Client Application Associate Spare Part
Form - Showing the Consumption Types available

3.12.1.3.5  Inactive Spare Parts

Inactive Spare Parts shows deleted Spare Parts that have been consumed in an Activity or a Fault.
Spare Parts that have not been consumed are not displayed here and are deleted permanently.

To "undelete" or "restore" an inactive Spare Part, check the Reactivate box of the Spare Part and
click "Restore."

The Administration Module Inactive Spare Parts List - Showing how to Restore Spare Parts

After restoring them, you will see the spare parts in the Spare Part tab.

3.12.1.4 Suppliers

Suppliers contains a list of the "fixed" fields found in a Supplier in the Client Application.  If you want
to go directly to a sub item, you can double click on its name to "jump" directly to that item. For
example, if you double click on Phone Types, you will be taken to the list of Phone Types.
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The Administration Module System Variables -> Client -> Suppliers List - Showing how to jump to child
items

To read more about a 'fixed' field in a Supplier, click on one of the links below:
· Phone Types

3.12.1.4.1  Phone Types

Phone Types represent the phones used by Suppliers. They could be mobile phones, land phones,
wired or wireless phones depending on the type of phones that your Suppliers use.

To learn how to assign Phone Types to a Supplier, please click here.

Let's take a look at how to add, edit and delete Phone Types.

Below, you will see the menu items for adding, editing (Properties...) and deleting.

The Administration Module Phone Types List - Showing how to add, delete and edit Phone Types

When you click 'New..,' you will see a dialog where the Type can be defined. You are required to
enter a Type.
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The Administration Module Phone Types Add Form

All the Phone Types that appear in the Administration Module can be selected in the Client
Application.

The Administration Module Phone Types List and The Client Application Supplier Add Form - Showing the
Phone Types available

3.12.1.5 Faults

Faults contains a list of the "fixed" fields found in a Fault in the Client Application.  If you want to go
directly to a sub item, you can double click on its name to "jump" directly to that item. For example,
if you double click on Stop Groups, you will be taken to the list of Stop Groups.

The Administration Module System Variables -> Client -> Faults List - Showing how to jump to child items
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To read more about a 'fixed' field in a Supplier, click on one of the links below:
· Cause Types
· Down-time Types
· Types
· Stop Groups

3.12.1.5.1  Cause Types

There is always a reason why Faults occur. Cause Types help you to immediately identify that
reason. If you need a more detailed description about what caused a Fault, you will be able to see it
in Fault Description.

To learn how to assign Cause Types to a Fault, please click here.

Now let's take a look at how to add, edit and delete Cause Types.

Below, you will see the menu items for adding, editing (Properties...) and deleting.

The Administration Module Cause Types List - Showing how to add, delete and edit Cause Types

When you click 'New..,' you will see a dialog where the Cause Type can be defined. You are required
to enter a Cause Type.

The Administration Module Cause Types Add Form

All the Cause Types that appear in the Administration Module can be selected in the Client
Application.
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The Administration Module Cause Types List and The Client Application Fault Add Form - Showing the
Cause Types available

3.12.1.5.2  Down-time Types

Machines break down from time to time and when they do, they are unable to provide service. Down-
time Types tell you why a Machine is currently unavailable.

Let's say you have a Machine that has stopped and in the details of its Stop, it was assigned a
Down-time Type of "Electrical." Based on this fact, you can immediately say that the Machine is
"down" because of an electrical problem.

To learn how to assign Down-time Types to a Stop, please click here.

Now let's take a look at how to add, edit and delete Down-time Types.

Below, you will see the menu items for adding, editing (Properties...) and deleting.

The Administration Module Down-time Types List - Showing how to add, delete and edit Down-time
Types

When you click 'New..,' you will see a dialog where the Down-time Type can be defined. You are
required to enter a name for the Down-time Type.
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The Administration Module Down-time Types Add Form

All the Down-time Types that appear in the Administration Module can be selected in the Client
Application.

The Administration Module Down-time Types List and The Client Application Stop Add Form - Showing
the Down-time Types available

3.12.1.5.3  Fault Types

Fault Types give a short description of a Fault. Let's say your car's computer suffers an "Electric
Failure." To give the Fault a quick description, you can use "Electric Failure" as its Fault Type. So,
whenever you see a Fault Type, you will get an idea of what the Fault is.

You might get confused with Fault Types and Cause Types because they appear to be similar. To
clearly distinguish between them, keep in mind that Fault Types, such as "Electric Failure" tell you
what kind of Fault occurred whereas Cause Types, such as "Moisture," tell you why the Fault
occurred. Of course, how you use Fault Types and Cause Types will depend on your business. They
are provided in PM5 for flexibility and convenience.

With Fault Types, you can also set an alarm that monitors the frequency of a Fault. If the alarm
goes off because a Fault happens too frequently, the Fault is displayed in red text in the Client
Application.

To learn how to assign Fault Types to a Fault, please click here.



237Administration Module

© 2010 PCSYS A/S

Now let's take a look at how to add, edit and delete Fault Types.

Below, you will see the menu items for adding, editing (Properties...) and deleting.

The Administration Module Fault Types List - Showing how to add, delete and edit Fault Types

When you click 'New..,' you will see a dialog where the Fault Type can be defined. You are required
to enter a Fault Type.

The Administration Module Fault Types Add Form

When you select a Fault and click "Properties...," you will see a dialog where you can set an alarm.
What you enter in the Frequency box will determine the number of days allowed in between Fault
occurrences before the alarm is triggered. This means that if you set a Frequency of "2" for a Fault
Type and the Fault repeatedly occurs within 2 days, an alarm will be triggered. If the Fault occurs
outside of 2 days, it will not trigger an alarm.

To enable the alarm, you must check the box labeled "Alarm when fault occurs too frequently."
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The Administration Module Fault Types Edit Form

All the Fault Types that appear in the Administration Module can be selected in the Client
Application.

The Administration Module Fault Types List and The Client Application Fault Add Form - Showing the Fault
Types available

3.12.1.5.4  Stop Groups

A Stop Group is used to categorize Stops. This is useful when you want to know if other machines
are affected by the stoppage of one Machine.

Let's say you have 3 machines namely CPU, Keyboard and Monitor that belong to one Stop Group
called PC. Due to heavy use your Keyboard breaks down and it affects the CPU and the Monitor.
Because they all belong to one Stop Group, it is understood that the Keyboard's stoppage affects
the other Machines in the Stop Group.

On the other hand, if the stoppage of the Keyboard did not affect any other Machine, its Stop Group
can be set to "Machine Specific," to make it clear that its break down only affects itself and no other
Machines.
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To learn how to assign Stop Groups to a Machine and how to set "Machine Specific" Stops, please
click here.

Now let's take a look at how to add, edit and delete Stop Groups.

Below, you will see the menu items for adding, editing (Properties...) and deleting.

The Administration Module Stop Groups List - Showing how to add, delete and edit Stop Groups

When you click 'New..,' you will see a dialog where the Stop Group can be defined. You are required
to enter a name for the Stop Group.

The Administration Module Stop Groups Add Form

All the Stop Groups that appear in the Administration Module can be selected in the Client
Application.
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The Administration Module Stop Groups List and The Client Application Machine Add Form - Showing the
Stop Groups available

3.12.2 Purchasing

Purchasing contains a list of the "fixed" fields as well as configurable options found in the
Purchasing Module. If you want to go directly to a sub item, you can double click on its name to
"jump" directly to that item. For example, if you double click on Settings, you will be taken to the list
of Settings.

The Administration Module System Variables -> Purchasing List - Showing how to jump to child items

To read more about a 'fixed' field in the Purchasing Module, click on one of the links below:
· Accounts
· Contact Information
· Settings
· Taxes
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3.12.2.1 Accounts

Accounts contains the list of accounts used in the Purchase module. An account in PM5 is similar
to a real world bank account. It has an account number, amount of money left in the account and
other information such as when the account was created and whether it is still open or has been
closed.

It is used when creating Purchase Orders in the Purchase Module. When a Purchase Order has
been sent and the Spare Parts ordered have been received, the cost of the Spare Parts are deducted
from the amount of money in the Account. To see how this is done in the Purchase Module, please
click here.

Now let's take a look at how to add, edit and delete Purchasing Accounts.

Below, you will see the menu items for adding, editing (Properties...) and deleting.

The Administration Module Purchasing Accounts List - Showing how to add, delete and edit Purchasing
Accounts

When you click 'New..,' you will see a dialog where the Account Number, Description, Person
Responsible for the Account (Responsible) and Starting Amount can be defined. You are required to
enter an Account Number.
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The Administration Module Purchasing Account Add Form

When you select an Account and click "Properties...," you will see a dialog that shows you the
amount used, amount available and the date the account was created in addition to the fields you
see when creating a new account. The amount used is the same as the cost of the spare parts that
have been ordered and received in the Purchase Module. To see how ordering and receiving is done,
please click here.

The Administration Module Purchasing Account Edit Form

All the Accounts that appear in the Administration Module can be selected in the Purchase Module.

The Administration Module Purchasing Accounts List and Purchase Module Order Form - Showing the
Accounts available
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3.12.2.2 Contact Information

Contact Information allows you to define the addresses for delivery and invoicing in a Purchase Order
and their associated phone and fax numbers.

The reason for having two addresses is that sometimes the address where the Spare Parts will be
delivered is different from the address where the bill should be sent to. For example, you could have
a warehouse as a delivery address and a corporate center as an invoice address. This way, the
Spare Parts will be brought to the warehouse and the bill will be sent to the corporate center.

Of course, how you use addresses depends entirely on how you conduct your business; it is
possible for you to have the same delivery and invoice address. The separation of addresses is a
feature that provides you with greater flexibility only if you need it.  To learn how to set the delivery
and invoice addresses in a Purchase Order, please click here.

Now let's take a look at how to add, edit and delete Purchasing Addresses.

Below, you will see the menu items for adding, editing (Properties...) and deleting.

The Administration Module Purchasing Addresses List - Showing how to add, delete and edit Purchasing
Addresses

When you click 'New..,' you will see a dialog where the Name, Street, Country, Zip Code, City,
Phone Number, Fax Number can be defined. You are required to enter a Name and a Street.

If you want to know how to define a Country, please click here.

If you want to learn how to create a City (and its corresponding Zip Code), please click here.
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The Administration Module Purchasing Account Add Form

When you select an Address and click "Properties...," you will see the boxes "Set as default
delivery address" and "Set as default invoice address." Here, default means the same as automatic.
So, if you check the default delivery address box of an address, that address automatically becomes
the delivery address for all new Purchase Orders unless you explicitly change it. The default invoice
address box also controls the invoice address for all new Purchase Orders.
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The Administration Module Purchasing Account Edit Form

All the Addresses that appear in the Administration Module can be selected in the Purchase
Module.
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The Administration Module Purchasing Addresses List and Purchase Module Order Form - Showing the
Addresses available

3.12.2.3 Settings

Settings allows you to control the behavior of the Purchase Module. To learn how to use the
Purchase Module, please click here.

Let's take a look at how to change Purchasing Settings.

The Administration Module Purchasing Settings List - Showing how to change the Purchasing Settings

When you click 'Properties..,' you will see a dialog where you can change various settings. What
each setting does is explained below.
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The Administration Module Purchasing Settings  Edit Form

Purchasing Settings:

· Use Limited Time Range For Current Orders - This setting works in combination with its
Number of Days To Show box. If you check this setting and enter "30" in its Number of Days
to Show box, orders that have not been closed will only be displayed within 30 days of the
date it was created.

· Use Limited Time Range For Historic Orders - This setting works in combination with its
Number of Days To Show box. If you check this setting and enter "30" in its Number of Days
to Show box, orders that have been closed will only be displayed within 30 days of the date it
was created.

· Receive Update: Inventory - If you check this setting, whenever Spare Part orders are received,
their inventory (Stock) in the Spare Parts Tab Stores Sub Tab in the Client Application gets
updated. If "5" Spare Parts are ordered and there are currently "3" of those parts, when those
Spare Parts are received the stock will be updated to have a value of "8" (5 + 3).
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The Client Application Spare Parts Tab - Stores Sub Tab - Showing a Spare Part's Inventory

· Receive Update: Cost Price - Checking this box causes a Spare Part's Cost Price to be
updated whenever an ordered Spare Part is received. You can enter a new Cost Price for a
Spare Part whenever you add a Spare Part to a Purchase Order. To see how this is done,
please click here.

The Client Application - Spare Parts Edit Form - Showing a Spare Part's Cost Price

· Delete Orders Older Than: Date - If you choose a date and click on the Delete button, all
Purchase Orders that were created before the selected date will be deleted.

· Invoice Notes - What you type in here will automatically become the invoice notes for all new
Purchase Orders, unless you explicitly change them.
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3.12.2.4 Taxes

Taxes allows you to change the names and percentages of the taxes in the Purchase Module. To
learn how to use the Purchase Module, please click here.

Let's take a look at how to change the taxes.

The Administration Module Purchasing Taxes List - Showing how to change the Purchasing Taxes

When you click 'Properties..,' you will see a dialog where you can change tax information.

The Administration Module Purchasing Taxes Edit Form

You can see these taxes in the Purchase Order form.
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The Purchase Module - Edit Purchase Order Form

3.12.3 OPC

What is OPC? It stands for “open connectivity via open standards,” according the OPC Foundation.
OPC, in PM5, is used for automatically updating Faults and Measured Parameters. To learn more
about Faults, please click here. To learn more about Measured Parameters, please click here.

You will find OPC useful when your Machines need to be closely monitored. To illustrate, let’s say
you are running four water-based air conditioning systems and you want to know if any of them
experience problems. If you connect them to PM5 via OPC, you will be able to monitor their
temperature and water levels and you will easily see if there are any problems because they will
automatically show up as Faults.

To be able to use the OPC features, you will need to have the OPC Core Components installed
with PM5 and a connection to an OPC Server. Please refer to the Installation Guide for instructions
on how to do this. You can also download the OPC Core Components Redistributable file from
the OPC Foundation if you don't want to run it from the PM5 installer.

If you don't have OPC compatible machines but would like to try out the OPC functions, you can use
an OPC Simulation Server. One such server is Iconics’ Free OPC Simulator Server, which you
can get from their website. You will need to have the OPC Core Components installed to be able to
use the simulation server.

If you want to go directly to a sub item, you can double click on its name to "jump" directly to that
item. For example, if you double click on Measured Parameters, you will be taken to the list of
Measured Parameters.

http://www.opcfoundation.org/
http://www.iconics.com/support/free_tools.asp
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The Administration Module System Variables -> OPC List - Showing how to jump to child items

To read more about the fields in OPC, click on one of the links below:
· Faults
· Measured Parameters

3.12.3.1 Faults

An OPC Fault is similar to a regular Fault in the way that both mean that an error has occurred in a
Machine. However, its major difference is that, unlike regular Faults, OPC Faults are automatically
generated by the OPC Server. This means that if your OPC connected Machine encounters a
problem, the OPC Server will send the details of the problem to PM5, which automatically generates
a fault based on the information sent.

To illustrate, here's an example: You have a radiator Machine in PM5. You recently connected that
radiator to an OPC Server and set it to send an error when it reaches 100 degrees Celsius. You have
also created an OPC Fault, which will be triggered when the OPC Server sends an error. Now, let's
say your radiator reached 100 degrees Celsius. What will happen is the OPC Server will send an
error to PM5. Once PM5 receives the error, it will create a new OPC Fault. Finally, If you take a look
at the Activities\Faults Tab, you will see that a new Fault has been created for your radiator.

To create a new fault using OPC you can do one of three things:

1) Action -> New...
2) CTRL + N
3) Right click the grid and select "New..."

Then you will get this form.
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The OPC-Faults New Form

Computer - refers to your computer name.
Server - the instance name of the server.
Machine - the name of the machine that you want to be monitored.
Fault Type - the fault of the machine that occurred.
Discovered By - the person who discovered the fault.
Falling Edge check box - means a change from high value to low value. If an OPC fault has a
falling edge checked, it means that PM5 will look for the OPC item to change from value 1 to 0.
When this occurs PM5 will create an associated fault in the PM5 database. If Falling Edge is not
checked, PM5 will look for the OPC item to change from value 0 to 1.
OPC Item - data received or sent by the OPC Server.

1) Select a Computer, the Server, the Machine name, Fault Type, who discovered the fault and an
OPC Item.
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2) Finally, click Ok. The created OPC Fault can also be seen in the Faults sub tab of the machine
where the OPC fault was associated.

Note: Computer, Server, Machine, Fault Type, Discovered By and OPC Item are required fields. You
cannot save an OPC Fault if any of the required fields are empty.

3.12.3.2 Measured Parameters

To create and use OPC Measured Parameter you can do one of three things:

1) Action -> New...
2) CTRL + N
3) Right click the grid and select "New..."

Then you will get this form.
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The OPC - Measured Parameter New Form

Computer - refers to your computer name.
Server - the instance name of the server.
Measured Parameter - the measured parameter to use.
Scan Rate: Minutes - the number of minutes PM5 should get data from the OPC Server.
MP Unit/ OPC Unit - this is used to compute for the ratio of Measured Parameter Unit to OPC Unit.
For example, if the value for the OPC item is 120 and OPC Unit Ratio is 60 then, the data from the
OPC Server will be divided by the value in the OPC Unit, in our case will be 120 / 60 = 3. The
quotient will then be entered in the Measured Parameter log. This is important because it ensures
that PM5 does not get too much high values for the counter reading of measured parameter that
OPC might transfer.
OPC Item - data received or sent by the OPC Server.

1) Select the Computer, Server, Measured Parameter and OPC Item in the list.
2) Enter the Scan Rate and Unit Ratio in their respective fields.

3) Finally, click OK.
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Note 1: Computer, Server, Measured Parameter, Scan Rate and OPC Item are required fields. You
cannot save an OPC Measured Parameter if any of the required fields are empty.
Note 2: The value you enter in Scan Rate represents the time in minutes. It also must always be a
whole number; it cannot contain any decimals.

When you close the Administration module and select the machine where the OPC Measured
Parameter was assigned, you will see the Measured Parameter readings from the OPC Server. To
do this, click the [...] button in the Details sub tab of the machine. Upon clicking on the […] button,
you will see the Measured Parameter form.

The readings created by the OPC Measured Parameter

3.12.4 Postal Information

Postal Information contains a list of the "fixed" fields as well as configurable options found in the
Supplier Add\Edit Form. If you want to go directly to a sub item, you can double click on its name to
"jump" directly to that item. For example, if you double click on Countries, you will be taken to the
list of Countries.
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The Administration Module System Variables -> Postal Information List - Showing how to jump to child
items

To read more about a 'fixed' field in the Supplier Add\Edit Form, click on one of the links below:
· Countries
· Zip Codes

3.12.4.1 Countries

Countries contains the list of Countries used in the Supplier Add Form and the Zip Codes Add Form.
To see how to select a country when creating a Supplier, please click here. To see how to select a
country when creating a Zip Code, please click here.

Now let's take a look at how to add, edit and delete Countries.
SE
Below, you will see the menu items for adding, editing (Properties...) and deleting.

The Administration Module Countries List - Showing how to add, delete and edit Countries

When you click 'New..,' you will see a dialog where the the Country can be defined. You are required
to enter a name for the Country.
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The Administration Module Country Add Form

All the Countries that appear in the Administration Module can be selected in the Supplier Add form
in the Client Application. 

The Administration Module Countries List and Client Application Supplier Form - Showing the Countries
available

They can also be selected in the Zip Codes Add Form in the Administration Module.

The Administration Module Countries List and Zip Codes Add Form - Showing the Countries available
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3.12.4.2 Zip Codes

Zip Codes contains the list of Zip Codes used in the Supplier Add Form. To see how to select a Zip
Code when creating a Supplier, please click here.

Now let's take a look at how to add, edit and delete Zip Codes.

Below, you will see the menu items for adding, editing (Properties...) and deleting.

The Administration Module Zip Codes List - Showing how to add, delete and edit Zip Codes

When you click 'New..,' you will see a dialog where the the Zip Code can be defined. You are
required to enter a Country, Zip Code and Postal District.

The Administration Module Zip Code Add Form

All the Zip Codes that appear in the Administration Module can be selected in the Supplier Add form
in the Client Application. 
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The Administration Module Countries List and Client Application Supplier Form - Showing the Zip Codes
available

4 Purchasing Module
The following paragraphs will tell you how to gain access to the purchasing module and will give you
a brief overview of its features.

To be able to access the purchasing module, you need two things:
· A PM5 license that includes access to the Purchasing Module
· A user account that has the privilege to use the Purchasing Module

If you would like access to the Purchasing Module but your current license does not include it,
please contact PCSYS at (45) 43 43 29 29 or info@pcsys.dk for instructions on how to upgrade your
license.

If your user account does not have access to the Purchasing Module, you will need to add it to a
User Group that has the "Purchase/Spare Part" privilege. For instructions on adding a user to a User
Group, please click here.

Once you have the correct license and an account that has the correct privilege, you will be able to
access the Purchasing Module.

Opening the Purchase Module

To open the Purchasing Module, log in to PM5 and point and click on Tools and click Purchase.

mailto:info@pcsys.dk
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After clicking on it you will be shown the Purchasing Module dialog.

From here, you can create, send, receive and close spare part Purchase Orders. You can also
create and print reports regarding Purchase Orders.

To read more about a specific topic, click on one of the links below:
· What is a Purchase Order?
· Create a Purchase Order
· Send an Order
· Receive Ordered Spare Parts
· Close an Order
· Create a Report
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· Print a Report
· How do I configure settings for the Purchasing Module?

4.1 What is a Purchase Order?
In PM5, a Purchase Order (PO) is an agreement between you and your supplier. It contains
information regarding what spare parts were ordered, the quantities and prices of those spare parts
and other related information such as where it will be delivered and who will pay for it.

If you send a PO to your supplier, you are giving an offer to buy his products. If your purchase order
is accepted, it forms a contract between you and your supplier.

To learn how to create a PO, please click here.

4.2 Create a Purchase Order
The following paragraphs will show you how to create a Purchase Order (PO) and add Spare Parts to
that order.

To create a new PO, right click anywhere in the Order Tab and click new.

The Purchasing Module - Order Tab - Showing how to create a new PO

You will see the Purchase Order window where you can enter some basic information regarding your
PO.
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The Purchase Order Window

You might notice that there are some fixed fields here, such as Account Numbers, Taxes and
Addresses, and would like to find out they can be be defined. This section will answer those
questions.

When you are done entering information, click Save. Now you are ready to select the Spare Parts
that will be included in your PO. These Spare Parts can be added via the Order Lines sub tab.

With your order selected, click on the Order Lines sub tab and click Add.



263Purchasing Module

© 2010 PCSYS A/S

The Purchase Module - Order Tab - Order Lines Sub Tab - Showing how to add to an Order Line

This will show you a list of all the Spare Parts in the database. To add a Spare Part to your current
order, right click on the Spare Part and click Add to Current Order.
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The Purchase Order Window - Spare Part Tab - Showing how to add a Spare Part to the Current Order

You will see the Order Line window. Type in the Quantity that you want to order and, if it is not
already there, also type in the Price and the applicable Discount for the Spare Part. When you are
done, click Save.
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The Order Line Window - Showing the relevant fields for ordering a Spare Part

Repeat this process if you want to add more Spare Parts to your PO. When you are finished adding
Spare Parts, you can now send your PO. To find out how to do that, please click here.



266 PCSYS Maintenance 5

© 2010 PCSYS A/S

4.2.1 Fixed Fields in a Purchase Order

Purchase Order Window - Showing the 'fixed' fields

You can find instructions on how to add and delete values from the above fields in the links below:
· Account Numbers 
· Taxes
· Settings

4.3 Send an Order
This section tells you how to send a Purchase Order (PO).

Sending an Order in PM5 means finalizing the order. Once you send an order, you will no longer be
able to edit it.

To send an order, right click on the desired PO and click Send.
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The Purchasing Module - Order Tab - Showing How to Send a Purchase Order

After you click Send, you will be given the option to view its report. This allows you to print your PO.
Click Yes to see a preview of how your PO will look like.

The Purchasing Module - View Report Dialog

You will now see a preview of the Purchase Order.
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The Purchase Order Report - Showing a Preview of the Purchase Order

4.4 Receive Ordered Spare Parts
Here, you will learn how to receive ordered spare parts.

Receiving ordered Spare Parts increases the stocks of those Spare Parts. You can view the stocks
of a Spare Part by looking at the Spare Part's Stores Sub Tab in the Client Application. To learn
more about stocks, please click here.

Before you can receive an order, it first needs to be sent. To learn how to send an order, please
click here.

To receive an order, right click on it and choose Receive.
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The Purchasing Module - Order Tab - Showing How to Receive a Purchase Order

You will see a dialog box that says the Order has been received. Click OK to close it. With your
order selected, click on the Order Lines sub tab and double click on the Order Line.
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The Order Line Window - Showing the relevant fields for receiving Ordered Spare Parts

Select who received the delivery, type in the Quantity Received and, if it is not already there, also
type in the Price and select the date when it was received. When you are done, click Save.

4.5 Close an Order
This section shows you how to close a Purchase Order (PO).

Closing a PO causes it to be moved from the list of current orders to the list of historic orders. When
a PO is in the list of historic orders, the number of days it is shown is limited by the value set in the
Administration Module. To learn more about current orders, historic orders and how to change their
values, please click here.

To close a PO, right click on it and select Close.
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The Purchasing Module - Order Tab - Showing How to Close a Purchase Order

You will see a dialog box that says the Order has been closed. Click OK to close the dialog box.

4.6 Create a Report
The following paragraphs will show you how to create a Report for a Purchase Order (PO).

The Reporting facility of the Purchase Module allows you to create POs that you can Email or Print.

To create a report, click on Reports in the file menu.

Select the PO that you want to be displayed in the From and To dropdown lists and click Full.
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The Purchasing Module - Reports Window - Showing How to Create a Purchase Order

You will see the report in the bottom half of the window.

The Purchase Order Report - Showing a Preview of the Purchase Order

4.7 Email a Report
The following paragraphs will show you how to save a Report of a Purchase Order (PO).

First you need to create a Report. Click here to find out how to create one.

When you have the Report opened, click on down arrow of the the Email icon in the toolbar.
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Click on your desired format, this will open a dialog box where you can enter extra settings such as
the Page Range, Image Quality, etc. Enter your custom settings and click OK.

You will be prompted to save the report. Select a location to save it and click Save.
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After you click Save, PM5 will open your email application where you can send the PO to your
Supplier or to other parties.

4.8 Print a Report
The following paragraphs will show you how to print a Report of a Purchase Order (PO).

First you need to create a Report. Click here to find out how to create one.

When you have the Report opened, click on the Print icon in the toolbar.

This will open the Printer dialog. Select your desired printer from the list and click OK.
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Assuming your printer has enough ink, paper and is in proper working order, you can now retrieve a
printed copy of your PO.



Endnotes 2... (after index)
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